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Copyright	

	 	  TimeValue Software, Inc. (a California corporation) 1984-2010, all rights 
reserved.  All trademarks and registered trademarks mentioned herein are 
property of their respective companies.

		  When you purchase a copy of TValue software, you are authorized to use 
it according to the terms of your license.  You may make backup copies for 
your own use only.  Please respect the rights of TimeValue Software and re-
frain from distributing copies of this software.  Such practices are in violation 
of copyright laws.

		  TimeValue Software licenses TValue amortization software on a per seat 
basis. This means that each TValue user must pay for a copy of TValue.  

		  For additional copies, contact TimeValue Software.

.

Support

		  If you have questions about TValue software that you cannot resolve with the 
user’s guide or on-line help, call Customer Support at 1-949-727-1800 or  
1-800-426-4741 (within USA).  Hours are Monday through Friday from 7:00 
am to 6:00 pm Pacific time.  You can also send your questions via email to 	
support@TimeValue.com.  We try to respond to all email support on a daily  
basis. Our customer support policy is subject to change at any time.

Guarantee	

		  If the program doesn't fit your needs, licensed users may return their software 
within one year of purchase.  TimeValue Software will promptly refund the 
purchase price.

Considerations	

		  TValue amortization software is a general purpose tool.  It can produce 
results at variance with legal, contract, or trade practice requirements.  As 
with any software tool, it’s up to you to use it appropriately.

TValue™ Amortization Software, Version 5 User's Guide

TimeValue Software
22 Mauchly
Irvine, CA 92618

Phone: 1-949-727-1800 
            1-800-426-4741 (within USA)
Fax:     1-949-727-3268
Web:   TimeValue.com
Email: info@TimeValue.com

ii



iv

		  Since 1984, TimeValue Software™ TValue™ amortization software has set 
the standard for time value of money calculations.  With TValue software, 
you’ll solve your most complex interest problems quickly and easily.  You 
can do more than routine loans.  TValue software handles balloon payments, 
multiple interest rates, fixed principal payments, skip payment loans, and 
much more.  In addition to normal (compound) amortization, there’s, 
U.S. Rule (simple interest - no compounding), Rule of 78, and Canadian 
amortization.  When you’re finished, TValue software prints amortization 
schedules that provide full documentation.

How to Use This User’s Guide

		  Refer to the Getting Started chapter to get the program up and running.

		  Work through the TValue Amortization Software Tour.  This will show you 
the overall operation of the program.

		  For more information about the operation of TValue software, refer to 
the TValue Amortization Software Basics chapter.  The Calculating and 
Creating Amortization Schedules chapter covers how to produce and print 
amortization schedules.

		  Work through a few examples.  After you’ve learned how things work, this 
user’s guide will serve as a useful reference.

Welcome to TValue Amortization Software
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Registering Your Copy of TValue Amortization Software
		  As a registered user of TimeValue Software™ TValue™ amortization 

software, you will receive technical support from the experts at TimeValue 
Software.  You will also receive product upgrade notifications and special 
offers for other TimeValue Software products.

		  To receive these customer services from TimeValue Software, please register 
your software immediately.  If you purchased TValue amortization software 
directly from TimeValue Software, you are already registered.

		  You can register your TValue software by any of the following methods:

	 •	 Call TimeValue Software at 1-949-727-1800 or call 1-800-426-4741 
(within USA) 

	 •	 Register on-line at www.TimeValue.com

Note   For the privacy of our customers, TimeValue Software does not sell or 
otherwise distribute customer information to any third party.

Checking Your System Requirements
		  Your computer and operating system must meet the following minimum 

requirements to run TValue amortization software, version 5.  

		  TValue amortization software, version 5 is a  32-bit Windows application.  
The software supports Windows 7, Vista, XP, 2000, ME, and Windows 
Server 2008, 2003, and Terminal Services.  Citrix is being used successfully 
by TimeValue Software customers with no known issues in this environment.

		  TValue amortization software requires 10MB or more of available RAM and 
5MB of hard disk space.

Registration and System Requirements

Getting Started
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Installing TValue Amortization Software
		  When you install TValue amortization software on your computer or server, 

installing it in the default directory is recommended.

To install TValue Amortization Software

	 1.	 Insert the TValue software CD into the CD drive. The TValue software 
installation screen will appear. This may take a few minutes.

	 2.	 Follow the on-screen instructions.

		  The install program will set up a directory named TValue5 (or directory of 
your choice) on your hard drive.  All of the TValue software program files 
will be copied into this directory.  A Windows program group will be created 
and a shortcut called "TValue 5" will be placed on your Windows desktop. If 
you are experiencing any difficulty installing TValue amortization software 
please contact support for assistance at 1-949-727-1800, 1-800-426-4741 
(within USA), or support@TimeValue.com.

		  If you are installing the network edition of TValue software, be sure to install 
the program to your network drive and refer to the following guidelines.

TValue Amortization Software on a Network
		  Your Network Edition of TValue software is designed to operate efficiently 

on your local area network.  It supports multiple users running the program 
from the same directory and individual setup files for each user.  After install-
ing TValue software on your network drive, please refer to the following 
steps to create an icon for each user/workstation.

To setup network workstations for TValue software
		  (Perform the following setup from each workstation after you install the soft-

ware on your network server.)

	 1.	 Go to the directory where TValue is installed (e.g., F:\TVALUE5).

	 2.	 Run TValue5 Client Setup.exe from the TValue program directory.

	 3.	 Follow the on-screen instructions. 

Installing TValue Amortization Software
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Upgrading From a Previous Version of TValue Software
		  TValue amortization software, version 5 will automatically convert and read 

files from earlier versions.  You can convert a file by simply opening it with 
TValue software, version 5.  When you save the file in version 5, it is saved 
in a TValue 5 format with a .tv5 extension on the file name.  The original 
TValue software, version 3 or 4 file (with a .tv3 or .tv4 extension) is undis-
turbed.

Note to TValue Report™ software, version 4 users

		  TValue Report software, version 4 does not recognize the TValue software, 
version 5 file format.  You can save files from TValue software, version 5 in a 
TValue software, version 4 format so they can be read by TValue Report, ver-
sion 4.  For more information about saving files, refer to the TValue Amorti-
zation Software Tour chapter.

Strategies for Users Working With Different Versions

Open TValue software version 4 schedules in version 5

		  You can open schedules created in TValue software, version 4 directly in 
TValue software, version 5.  All data and formatting created in this version of 
TValue software is fully supported in TValue software, version 5.

Share schedules with version 4 users

		  To share a TValue software, version 5 schedule with users of TValue soft-
ware, version 4, the schedule must be saved in the version 4 format. 

		  1. From the File menu, select Save As. 

		  2. In the Save As dialog box click the Save as type drop down menu.

		  3. Select TValue 4 Files (*.tv4) and save. 

		  When you save, TValue software warns you of settings or features that will 
not be supported by TValue software, version 4.  It then replaces the settings 
that are not supported by version 4 with settings that are supported by that 
version.  For more information about saving files, refer to the TValue Amorti-
zation Software Tour chapter.

Installing TValue Amortization Software
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Starting and Exiting TValue Amortization Software

Starting TValue Software
		  After installing TValue software on your hard drive, you can start the pro-

gram by double clicking on the shortcut icon that was placed on your desk-
top.

OR

	 1.	 Click Start and select Programs.

	 2.	 From the Programs list, select the TValue 5 menu and choose the TValue 
5 menu item.

		  The startup display appears temporarily.  It shows the program name, version, 
and copyright information.

		  After a few moments, TValue software will open a new schedule that dis-
plays the Cash Flow Data and Amortization Schedule tabs.

Closing the Schedule and Exiting TValue Software
		  If you’re ready to work on another problem, you can save your current sched-

ule and close its window to remove it from your screen.  You can also open 
another schedule without closing the current schedule.

		  When you’re finished working with TValue software, you can exit the pro-
gram.

Closing a TValue Software Schedule

	 1.	 From the File menu, choose Close.

		  If you haven’t saved the schedule before you close the file or quit, TValue 
software will ask whether you want to save changes to the schedule.

	 2.	 Click Yes to save the schedule, No to close the schedule without saving, 
or Cancel to return to the TValue software schedule without saving.

Exiting TValue Software

	 1.	 From the File menu, choose Exit.

		  If you haven’t saved your work, TValue will ask whether you want to save 
changes to the schedule.  Click the button of your choice.
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		  This chapter is designed to quickly familiarize you with the features of  TimeValue 
Software TValue amortization software.  Along the way, you'll learn the basics 
of structuring a simple loan and printing an amortization schedule so you 
can get started right away.  The ideas and procedures mentioned here are 
described in greater detail in subsequent chapters of the user's guide.

Entering Sample Loan Information
		  Facts    Lockwood borrows 21,646 to finance the purchase of an auto on  

April 15, 2007.  The annual interest rate is 8 percent, and the loan is to be 
repaid in 60 equal monthly payments beginning June 1, 2007.

		  Needed    The monthly payment amount and an amortization schedule.

Entering a Label

		  The label is an optional field that lets you enter a description of the note you 
are working on.  The description you type in the label field will appear on 
printed reports unless you choose to omit it.

	 1.	 Type Lockwood automobile loan and press Tab or Enter.

		  If you make a mistake, click the Label field and edit the text.  To enter 
additional lines of text, click the >> to the right of the Label field.

Selecting a Compounding Period

	 1.	 Click the Compounding period field to display available choices.

	 2.	 Select Monthly as the Compounding period and press Tab or Enter.

A Simple Loan Example
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Entering an Interest Rate

	 1.	 At the Nominal Annual Rate field, type 8.

	 2.	 Click the >> to the right of the Nominal Annual Rate field to display the 
Interest Rate dialog.

		  Note that TValue amortization software has calculated three other interest 
rates based on the compounding period chosen.  You can enter any of the 
rates first and TValue software will compute the others.

	 3.	 Click OK or press Enter to close the Interest Rate dialog.  Move to the 
the first cash flow line by pressing Tab or clicking on line 1.

Entering the Loan Event, Date, and Amount

		  The details of the loan and payments are entered on individual cash flow lines 
which are numbered on the left hand side of the Cash Flow Data window.  
You can enter and arrange information on cash flow lines in a logical progres-
sion.  

		  The first cash flow line automatically appears in the Cash Flow Data window.  
The Date defaults to your system date.

	 1.	 Select Loan as the event for the first cash flow line.

		  Events include Loan, Payment, Deposit, Withdrawal, Rate Change, and 
User events.  User events can be named to suit your needs by selecting 
Event Names from the Setup menu or right-click menu.  The right-click 
menu is explained in more detail on pages 41 and 97.

Note    If you work with events other than loans, such as deposits or leases, 
you can change the initial default event by choosing Input Setup from the 
Setup menu.  

	 2.	 Press Tab or click the Date field and type 041507.

		  This is the date the auto loan starts to accrue interest.  TValue amortiza-
tion software will display 04/15/07 when you move to the next field.  You 
can also input dates with separators between characters such as 4-15-07 
or 4/15/07.  The year can also be entered as four digits.

	 3.	 Press Tab or click the Amount field and type 21646.  This is the amount 
of the auto loan.  

	 4.	 Press Tab again and TValue software will display 21,646.00.

A Simple Loan Example
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Tip    From the loan amount field, you can display the Points and Fees dialog 
for entering loan charges and prepaid interest that are used to compute the 
Annual Percentage Rate.  To display the dialog, use any of the following 
methods: (1) Press "P" from the Amount field, (2) Click in the far right 
untitled column of the first cash flow line, or (3) Right-click the first line and 
choose Points and Fees.

		  The Number field shows the number of times the event occurs at regular 
intervals.  For loans, the default is 1 since loans usually occur one time.

	 5.	 Press Tab or Enter to accept 1 as the number of loans.

		  The number 1 will remain in the Number column.  The Period and End 
Date fields are skipped because there is only one loan.  A second cash 
flow line will be created.  

		  Your Cash Flow Data window should now appear as shown below.

Entering the Payment Dates and Amounts

		  Payment is the default event on the second cash flow line because Loan is the 
first event.  If Deposit were the first event, Withdrawal would default here.

	 1.	 Press Tab or click the start Date field and type 060107.  This is the date 
of the first payment.  

	 2.	 Press Tab to move to the Amount field.

	 3.	 Press U to designate the payment amount as unknown.  The word "Un-
known" will appear in the Amount field.

A Simple Loan Example
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Tip    From the payment Amount field, you can display the Special Series 
dialog to create special payments such as interest only or fixed principal.  To 
display this dialog, use any one of the following methods: (1) Press "S" or F2 
from the payment amount field, or (2) Click in the far right untitled column 
on the cash flow line, or (3) Right-click the line and choose Special Series.

	 4.	 Press Tab to move to the Number field.

	 5.	 Type 60 in the Number field and press Tab.  This is the number of 
monthly payments during the 5 year period.

		  The word Monthly will appear in the Period field.  The period is the 
length of time between the events on a given cash flow line.  The End 
Date, in this case 05/01/2012, is the date of the last payment in the series 
and is calculated automatically.

		  Your Cash Flow Data window should now appear as shown below.

Solving for the Unknown
		  Once you enter the details of the loans and payments, you can quickly calcu-

late the value of any unknown.

Calculating the Payment Amount

	 1.	 Click Calculate on the tool bar or choose Calculate Unknowns from the 
Compute menu to compute the unknown payment amount.

		  Solution    The monthly payment amount of 440.44 will appear in the 
Amount field.

A Simple Loan Example
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	 2.	 Click Rounding on the tool bar to check rounding.  

		  This displays the Rounding dialog and gives you a chance to deal with 
any leftover rounding amounts.

		  TValue software has internally checked the amortization schedule for any 
rounding adjustments.  A balance of 9 cents remains.

	 3.	 Click the Ignore button to ignore the rounding adjustment, and click OK 
to close the dialog.

		  TValue amortization software will change the interest included in the last 
payment from 2.92 to 2.83 in order to make the final balance zero.

		  If you select Last Payment, the last payment will increase by 9 cents.

A Simple Loan Example
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Displaying and Printing the Amortization Schedule
		  You can produce a detailed amortization schedule from the cash flow data 

you enter in the TValue amortization software.  The amortization sched-
ule shows the details of interest and principal and can be modified for your 
needs.

Displaying and Printing the Amortization Schedule

	 1.	 Click the Amortization Schedule tab.

		  The amortization schedule is displayed as shown on the following page.

	 2.	 Use the scroll bars or arrow keys to move to the end of the report.  You 
will see the grand totals and the message “Last interest amount decreased 
0.09 due to rounding.”

	 3.	 To print the amortization schedule, click Print on the tool bar.  

	 4.	 If you had entered any points or fees for the loan, the APR disclosure 
would appear at the end of the amortization schedule.

		  You can also view the amortization schedule in Excel or Word by click-
ing the appropriate button at the top of the amortization schedule.  This 
action would automatically open Excel or Word with the data already 
exported in that format.

A Simple Loan Example
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Saving Your Work
		  To save your data, you must give the file a name and save to drive.

Saving a TValue Software File

	 1.	 From the File menu, choose Save, or click Save on the tool bar.

		  If you are saving the schedule for the first time, TValue amortization 
software displays the Save As dialog.

	 2.	 The text you typed in the Label field has defaulted in the File name field 
in the Save As dialog.  The file will be saved in the open directory as 
Lockwood automobile loan.tv5.  TValue amortization software will auto-
matically add the .tv5 extension.

		  To save the schedule so it can be read by version 4 of TValue software, 
you can choose TValue 4 Files (*.tv4) from the Save as type field. 

	 3.	 Click Save.

Creating a New TValue Software Schedule
	 1.	 From the File menu, choose New, or click New on the tool bar.

		  TValue amortization software opens a new schedule in a window over the 
existing schedules.  The new schedule is named Schedule#, where # is the 
number of schedules opened since starting TValue software.  You can change 
the name when you save.

A Simple Loan Example
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Opening a TValue Software File
	 1.	 From the File menu, choose Open, or click Open on the tool bar.

		  The directory dialog that appears will list all TValue software version 5 
files in the current directory.  To show version 3 or version 4 files, select 
the appropriate type from the Files of type field.

	 2.	 Double-click a file name in the list or select it and click Open.

Deleting a TValue Software File
	 1.	 From the File menu, choose Open.

	 2.	 Select the drive and directory where the file is located.  Right-click on the 
file name you wish to delete.

	 3.	 Select Delete from the drop-down menu.  Click Yes to delete the file.

	 4.	 Click Cancel to close the Open dialog.

		  The deleted file will be placed in the Windows Recycle Bin where it will 
remain until you empty the Recycle Bin.

A Simple Loan Example
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A Simple Loan Example

Changing the Default Directory
		  When you choose Save or Open from the File menu, TValue software will 

use the default directory in the Open and Save dialog boxes.  The initial 
directory that appears can be changed from the Input Setup window on the 
Setup menu.  Afterwards, when you use the Save or Open command, TValue 
software will automatically access the directory you have specified.

	 1.	 From the Setup menu, select Input Setup or press F5.

	 2.	 In the Initial Directory field, click the Browse button and select the drive 
and directory where TValue software looks for files when you save and 
open.  You can also type the path directly in the Initial Directory field.

	 3.	 Select the Save settings from ALL tabs as the default for new 
schedules checkbox at the bottom of the dialog.

	 4.	 Click OK or press Enter.  

Getting Help

Using the Input Assistance

		  The help box in the Cash Flow Data window displays information about 
most fields.  This information is especially helpful for first time users of  the 
software.  You can turn this help box off from the View menu.

Getting Help about a Particular Field

		  From almost any field, the F1 key brings up a help message based on where 
you are in the program.

	 1.	 From most fields, press the F1 key.  A window will appear on the screen 
with a message that explains the field.

Getting Help for a Particular Topic

	 1.	 Choose TValue Help Contents from the Help menu.

		  The Help Index displays a list of help subjects.

	 2.	 Click any topic to display information for that topic.

	 3.	 Click any underlined items to display information specific to that item.
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		  Regardless of whether you are working on an investment, mortgage, present 
value, or future value, you can enter the facts in TimeValue Software TValue 
amortization software.  Most interest calculations involve relationships 
between amounts, dates, and interest rates.  You tell the program what 
happens and when.  TValue amortization software does the rest.

		  This chapter explains the TValue software working components so you can 
quickly get started on your projects.  If you are familiar with Windows and 
perhaps even an earlier version of TValue software, you will quickly feel 
comfortable with TValue software, version 5.

		  It’s easy to move around in TValue software.  Commands and functions are 
accessed from the main screen and from the menu bar at the top of the screen.  
Use the right mouse button to conveniently access  many functions.  You can 
move between fields in a schedule by pressing the Tab or Enter key.  

The TValue Software Schedule
		  The TValue software Schedule consists of four sections.  The menu bar and 

tool bar appear at the top of the TValue software schedule.  The Cash Flow 
Data window appears below the tool bar and contains areas to enter interest 
rates and cash flow information.  The Amortization Schedule window dis-
plays the results from the information entered in the Cash Flow Data window.

Menu Bar

		  The menu bar is visible on the top line of the TValue software schedule.  The 
commands available from these menus include basic file and edit operations, 
such as opening and closing files and cutting and pasting.  They also include 
functions available from the Cash Flow Data window, such as adding a cash 
flow line or specifying points and fees for a loan. 

		  You can choose to use keyboard equivalents for many commands, such as 
calculating and sorting cash flow lines.  These shortcuts appear in the menus 
to the right of the commands.

Overview of the TValue Amortization Software Environment
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Tool Bar

		  Just under the menu bar is a row of buttons called the tool bar.  These buttons 
let you quickly choose commonly used commands.  They perform the same 
actions as the corresponding commands in the Edit, Compute, and File 
menus.

Cash Flow Data Window

		  The Cash Flow Data window is where you record the facts of the problem 
that you are working on.  These facts usually include interest rates, loan or 
deposit amounts, and number of payments or withdrawals.

		  As you move through the fields in the Cash Flow Data window, you can 
enter information or choose an option from a drop-down menu.  If you don’t 
know a particular variable, type “U” in the appropriate field to declare it as 
unknown.

		  The Label provides a description of the problem you are working on.  The 
Compounding and Nominal Annual Rate fields specify the compound 
period and interest rate for the problem.

		  The details of loans, payments, deposits, withdrawals, and interest rate 
changes are entered on individual cash flow lines.  The Event specifies the 
type of activity on a cash flow line and the direction of the cash flow.

Overview of the TValue Amortization Software Environment
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		  The Date indicates when the first event on a cash flow occurs.  The Amount, 
Number, and Period specify the amount of each event and how many times 
it occurs at regular intervals.  This allows you to enter a series, such as 360 
monthly mortgage payments, on a single cash flow line.  The End Date indi-
cates when the last event in a series occurs.

		  The compute settings for the current schedule are displayed at the bottom left 
of the TValue amortization software schedule.  You can click on the displayed 
settings to quickly access the Compute Setup dialog where you can change 
the settings.

Amortization Schedule Window

		  The Amortization Schedule window displays the amortization schedule for 
the information that is entered in the Cash Flow Data window.  When you 
click on the Amortization Schedule tab, the window is displayed after any 
necessary calculations are made.  Any changes you make while the schedule 
is displayed are dynamically changed on the displayed schedule.

		  You can return to the cash flow information after viewing the amortization 
information by clicking on the Cash Flow Data tab.  The F4 key will also 
alternate between the Cash Flow Data tab and the Amortization Schedule tab.

Further Information About TValue Software

		  This user's guide contains the basic information to get you started using 
TValue amortization software.  It also contains a number of examples that 
focus on some specific applications for the program.

		  If you have questions that are not answered in these pages, we encourage you 
to use the TValue software Help system.  The TValue software Help contains 
much more detailed information about the features in TValue amortization 
software, as well as explanations of many calculations and definitions of 
frequently used terms.

		  The Help system can be accessed from the Help menu.  You can also display 
help from individual fields in the program by pressing F1.

Overview of the TValue Amortization Software Environment
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Adding and Editing a Label

		  The Label field lets you enter a description of the schedule you are working 
on.  It is an optional field and you are not required to enter a description here.  
When you enter a description in the Label field, the label can be printed on 
the amortization schedule.  If you do not want to print it, leave the Label field 
blank or deselect the Label check box in the Report Setup dialog.

		  When you save a TValue software schedule, the first 50 characters from 
the Label field will default as the file name in the Save As dialog.  You can 
change the name of the file before you save.

To add a Label to the schedule you are working on

	 1.	 Click the Label field and enter the description of the schedule you are 
working on.  If the length of your description extends beyond the length 
of the Label field, a text box will appear to accept a longer description as 
shown below.

	 2.	 Click OK when you are finished with the Label text box.

To edit the Label

	 1.	 Click within the Label field and edit the text you wish to change.

		  To replace the existing text in the Label field, double-click to highlight 
all the text and type a new description.  If the description of the schedule 
you are working on extends beyond the length of the Label field, click on 
the >> symbol at the right of the Label field to display the Label text box.

	 2.	 Click OK when you are finished with the Label text box.

		  Along with the label, you can create a header and a footer for amortiza-
tion schedules.  Headers and Footers are discussed in detail in the Help 
about Headers and Footers.
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		  Several factors are important when computing the time-value-of-money.  
These factors include the method used to compute interest, the rate at which 
interest is charged, and the frequency of compounding.  You can specify 
the method TValue software uses to compute interest by choosing Com-
pute Setup from the Setup menu.  The rate and frequency of compounding 
are specified by the Nominal Annual Rate and Compounding fields on the 
TValue software schedule.

Choosing a Compounding or Rate Period
		  The Compounding field controls how often interest is compounded.  Com-

pounding usually occurs at the same frequency that payments are made.  It 
may also occur more frequently than payments, such as with daily com-
pounding and monthly payments.

		  Compounding cannot, however, occur less frequently than payments.  
Monthly payments, for example, cannot be combined with an annual com-
pound period.

		  The Compounding field is renamed Rate Period automatically when U.S. 
Rule (Simple Interest) amortization is selected.  The Rate Period determines 
the way interest is calculated (e.g., Exact days vs. Monthly).

To choose a compounding period

	 1.	 Click on the Compounding field to display a drop-down list of com-
pounding periods.

		  The compounding period currently in effect will be highlighted.  

	 2.	 Click on a compounding period or press the first letter of your choice.

To change the default compounding or rate period

	 1.	 To change the default compounding period that appears when you begin 
new schedules, choose Input Setup from the Setup menu and select a 
default Compounding or Rate Period.

	 2.	 Select the Save settings from ALL tabs as the default for new sched-
ules checkbox at the bottom of the dialog.

	 3.	 Click OK.

Entering Interest Information
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Entering an Interest Rate
		  The interest rate shown on the main screen is the Nominal Annual Rate.  This 

is the rate quoted for most financial arrangements.

		  Click the >> to the right of the Nominal Annual Rate field to enter or view 
corresponding interest rates, such as the effective, periodic, and daily rate.

		  If the interest rate is known, it is entered as a percentage (e.g., 8.5 percent is 
entered as 8.5).  If you are trying to solve for the interest rate, you can declare 
it as unknown by typing U in any of the interest rate fields.  TValue amortiza-
tion software uses the other variables to calculate the interest rate.

To enter an interest rate

	 1.	 Enter the rate as a percentage in the Nominal Annual Rate field.

		  Interest rates can be entered with up to five digits to the right of the 
decimal.  They are stored as entered but are displayed rounded to the 
third decimal place.  If you enter a nominal rate of 12.34567 percent, it 
will be displayed as 12.346 percent but will calculate using 12.34567 
percent.  When you edit the rate, it will display all digits.

		  To view or enter an effective, periodic, or daily rate, click the >> at the 
right of the field to display the Interest Rate dialog.  In the Interest Rate 
dialog, you can enter up to 10 digits to the right of the decimal.  

To calculate an interest rate

	 1.	 Press U at the Nominal Annual Rate field or any of the rate fields in the 
Interest Rate dialog.  The word Unknown will appear in the Nominal 
Annual Rate field.

	 2.	 Enter the information for the schedule and click Calculate on the tool 
bar.  The calculated rate will appear in the Nominal Annual Rate field.

Entering Interest Information
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Nominal Annual Rate

		  The nominal annual rate is what is typically quoted when talking about 
interest rates.  If the compound period is annual, the nominal annual rate is 
equal to the effective annual rate, which is also equal to the periodic rate.  If 
the compound period is monthly, the nominal annual rate is equal to 12 times 
the periodic rate.

Effective Annual Rate

		  The effective annual rate is equal to the nominal annual rate if the compound 
period is annual.  In all other cases, (where the interest rate is positive) the 
effective annual rate is greater than the nominal annual rate because of the 
effects of compounding.

Periodic Rate

		  The periodic rate (rate per compound period) is the rate that is multiplied 
times the balance at the beginning of a compound period.  This rate times the 
number of compound periods per year gives the nominal annual rate.  For 
example, if compounding is monthly and the periodic rate is 1 percent, the 
nominal annual rate is 12 percent.

Daily Rate

		  The daily rate is defined as 1/365 of the nominal annual rate for a 365-day 
year, 1/364 of the nominal annual rate for a 364-day year, or 1/360 of the 
nominal annual rate for a 360-day year.  This rate is used for computing 
interest for odd days or stub periods, and for daily interest calculations.  Year-
lengths are described on page 63 of this user's guide.

		  For further discussion about the nominal annual, effective annual, periodic, 
and daily rates, refer to the TValue amortization software Help.

Entering Interest Information
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		  Specify the details of loans, payments, deposits, withdrawals, and interest 
rate changes on cash flow lines within the Cash Flow Data window.

		  Most problems include regular patterns of payments.  A home loan, for 
example, calls for 360 equal monthly payments.  This payment series can be 
entered on a single cash flow line.  Choose the event, date, amount, number 
of payments, and payment period once to specify the entire series.

		  TValue software provides dialogs to enter loan charges or special payment 
series like interest only payments or fixed payments to principal.

Choosing an Event
		  An event describes the activity on a cash flow line.  Choose the event that 

best describes the cash flow you are working on.  If needed, you can create 
new event names for your own terminology.

		  If you are unsure whether to use loans and payments or deposits and with-
drawals, experiment with the combination that seems to make sense.  The 
Deposit event, for example, works best for many investments.  The Loan 
event works well for mortgages because it allows you to enter points and 
fees.  In most cases, both events will give the same results.

To choose an event for a cash flow line

	 1.	 From the Event field on a cash flow line, press the first letter of the event 
name and press Tab.  You can also choose an event from the drop down 
list by clicking on the desired event.

		  If an event is not available from the event field, delete all but the first cash 
flow line from the Cash Flow Data window.  This will make other event  
types available.  If some events still do not appear in the event list, go to the 
Setup menu and choose Event Names.  Select the desired event groups.

Entering Cash Flow Information
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		  Once you select an event on line 1, the list of available events on the follow-
ing lines will only include the events that correspond with the event on line 1.  
For example, if you select a Loan on line 1, you will only see Loan, Payment, 
and Rate Change as event choices on succeeding cash flow lines of your 
schedule.

		  The default event name that automatically appears on the first cash flow line 
can be changed by selecting Input Setup from the Setup menu, and setting 
the Event field to the desired default.

Loan

		  A loan event is typically the first event in lending transactions, although it’s 
possible to lead off with a payment.  In TValue software, a loan is simply a 
cash flow that goes in the opposite direction of a payment.

		  Loans are associated with payments in the same way that deposits are associ-
ated with withdrawals.  In most cases, you can use loans and payments or 
deposits and withdrawals to get the same results.  The functional difference 
between a loan and a deposit in the software, is that you can enter finance 
charges (points, etc.) for a loan, but you can’t have a special series for a loan 
(percent step, etc.).  With deposits, you can have special series, but you can’t 
have finance charges and annual percentage rate calculations.

Payment

		  In the program, a payment is a cash flow in the opposite direction of a loan.  
It is used in conjunction with the loan event.  Payments occur individually or 
as part of a series (e.g., 36 monthly payments).  Payments can have any of the 
special series, such as Fixed Principal + Interest and Percent Step.  

Deposit

		  With TValue software, a deposit is a cash flow in the opposite direction of a 
withdrawal.  Deposits can be used with special event series except Interest 
Only and Fixed Principal + Interest.  Deposits should not be used if you are 
entering finance charges or computing the annual percentage rate.  

Withdrawal

		  In TValue software, a withdrawal is a cash flow in the opposite direction of 
a deposit.  It is used in the same problems as the deposit event.  Withdrawals 
support all special series.

Entering Cash Flow Information
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Rate Change 

		  A Rate Change establishes a new interest rate effective on the date shown 
in the Date field.  The Rate Change event triggers compounding unless you 
specify the compound period to be none.  The amount, number, payment 
period, and end date columns are skipped.  You can set a new compound 
period along with the new interest rate.

User Events

		  User events allow you to create new descriptions for events.  For example, 
if you work with leases, you can create lease, commission, lease payment, 
and residual events to use on cash flow lines.  You can create these events by 
assigning new names to the user loan and payment events.  When used in a 
schedule, these new events will appear as lease, lease payment, etc., but will 
function exactly like loans and payments.  When user event names are used, 
they will appear on the amortization schedule.

To create a new user event name

	 1.	 From the Setup menu, choose Event Names or press F8.  The Event 
Names dialog will appear.

	 2.	 Add or edit the event names you want to use in a schedule.  Each name 
can contain 30 characters. 

Entering Cash Flow Information
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		  If you want to return the event names to the original TValue software 
defaults, click the Reset button.

		  If you edit event names that are being used on the active TValue software 
schedule, the new names will be reflected in the Cash Flow Data window.

	 3.	 Select the event name groups that will be included as choices on sched-
ules by checking the appropriate check box.

		  To use the selected event names as defaults for new schedules, be sure to 
select Save settings from ALL tabs as settings for new schedules.

	 4.	 Click OK when you are finished adding event names.

Entering the Date
		  The Date field on a cash flow line shows when the event takes place.  It also 

specifies when interest starts to accrue for the period.  The date represents the 
date of a single event or the date of the first event in a series.  The last event 
in a series is indicated by an End Date at the right of the cash flow line.

		  You can enter events out of chronological order if needed.  TValue software 
will accept dates in any order.  The events must be sorted, however, before 
calculations can be done or an amortization schedule can be produced.

To enter the date for a cash flow line

	 1.	 Tab to or click on the Date field.

	 2.	 Type the date in any of the following formats: 061507, 6-15-07, or         
6/15/07.  TValue software adds the separators that are defined in the Win-
dows Control Panel after you move to the next field.

	 3.	 Press the Tab or Enter key.

  		  The default date on the first cash flow line will be the current date.  Default 
dates on later cash flow lines will be one payment period after the end date 
on the previous line, or one compound period later if no payment period has 
been established.  The start date for a Rate Change event will default to the 
end date of the previous cash flow line.

Entering Cash Flow Information
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		  When the start date of a series is the last day of a month (e.g., November 30 
or February 28), the events in that series will all fall on the last day of each 
month.  If you want events to fall on a particular date (e.g., November 30 
start date with payments on the 30th of each month), separate these events 
from the rest of the events in a series.  Then start a series for the remaining 
payments beginning on a date that is not a month-end (e.g., December 30).

To enter dates out of order

	 1.	 Enter events in any order.  If an alert box appears when you enter dates 
out of order, click OK to allow entry of dates out of order.  After you 
enter the events, you can use the Sort command to place them in order.

Entering the Amount
		  The Amount field on a cash flow line specifies the amount of the event.  	

Unknown amounts can be entered by typing U in the Amount field.

To enter the loan, payment, withdrawal, or deposit amount

	 1.	 Tab to or click on the Amount field of a cash flow line.

	 2.	 Enter an amount with or without decimals.  TValue software will auto-
matically add commas.

		  TValue software has two amount-entry modes: default and whole dollar.  The 
default mode lets you enter amounts with dollars and cents.  Whole dollar 
mode is primarily used for entering very large amounts without cents.  To 
set this option, choose Input Setup from the Setup menu and select Whole 
Dollar.

		  Depending on the event on a cash flow line, pressing F2 or clicking in the far 
right column displays a dialog for entering information, such as points and 
fees or type of payment series for that cash flow line.  For more information 
about entering points and fees and special payment series, refer to the Special 
Series section in this chapter.

To calculate the amount

	 1.	 Press U in the Amount field.  

	 2.	 Enter all the variables for the schedule you are working on.

	 3.	 Click Calculate on the tool bar.  The calculated amount will be displayed 
in the Amount field that was designated Unknown.

Entering Cash Flow Information
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Weighted Unknowns

		  Weighted unknowns let you calculate an amount that is a product of an 
unknown amount and a specified multiplier.  With weighted unknowns you 
can specify the relationship that each payment has to another.  For example, 
you may solve for two unknown payments where one is an unknown amount 
and the other is twice the unknown amount.

		  Weighted unknowns are useful where you have 2 payments up front followed 
by a series of regular periodic payments.  Typing 2x in the amount field 
would specify the two up front payments.  On the next cash flow line, the 
remaining periodic payments would be specified by typing 1x or U in the 
Amount field.

		  When calculated, the first payment would be twice the amount of the 
remaining payments.

Entering Cash Flow Information
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Entering the Number of Events
		  The Number field on a cash flow line indicates the number of times the event 

occurs.  For loans, the number is usually 1 because there is usually only 1 
loan.  For payments, this will be the number of payments that will be made 
(e.g., 360 monthly mortgage payments).

To specify the number of events

	 1.	 Tab to or click the Number field on a cash flow line.

	 2.	 Enter the number of loans, payments, deposits, or withdrawals.  If more 
than one (e.g., 360 monthly mortgage payments), enter the number that 
occurs before the event on the next cash flow line.

To calculate the number

	 1.	 Press U at the Number field.

		  The word Unknown will appear in the field as shown below.

		  When you choose unknown as the number of events, the End Date field 
will display Pending.  The End Date will be calculated and displayed 
when you solve for the number of events.

	 2.	 Enter all the remaining variables for the schedule you are working on.

	 3.	 Click Calculate on the tool bar.  The calculated number will be displayed 
in the Number field that was designated  unknown.  The End Date will 
also be calculated.

		  Many times when solving for the Number, the answer is not an even 
result.  TValue software will automatically display the Rounding dialog 
in order to address the odd amount.

Entering Cash Flow Information
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Choosing the Period
		  The period is the time between the events on a given cash flow line.  The 

period is usually the same as the compound period.  This field is used if the 
number on a cash flow is greater than one.  Otherwise, it is skipped.

To set the event period

	 1.	 Click on the Period field on a cash flow line to display a drop-down list 
of event periods as shown below.  

	 2.	 Click the event period you want.

		  Some periods may not be compatible with the compound period in effect.  
This occurs if you choose a period on a cash flow line that is shorter than the 
compound period.  TValue software will display an alert if there is a conflict.

Note    Canadian computations often involve events that occur more 
frequently than the compounding period.  TValue software handles these 
types of calculations when the computation mode is Canadian.  The Canadian 
setting is explained later in this chapter.

End Date
		  The End Date indicates the day of the last event in the series.  This date is 

computed automatically.  To enter dates in order, the starting date on each 
cash flow line must fall on or after the End Date of the preceding series.

		  When the number of payments on a cash flow line is unknown, the End Date 
will show Pending until the unknown number has been computed.
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Entering a Rate Change Event
		  The Rate Change event allows you to add an interest rate change at any point 

in the schedule.  When you select the Rate Change event, the Rate Change 
dialog will appear.

		  The Rate Change dialog lets you enter the date the rate change takes effect, 
the new interest rate, and the compounding of the interest that occurs from  
the rate change date forward.

		  To view or enter the effective annual, periodic, or daily rate, click the >> in 
the Rate Change dialog.

		  The date for a Rate Change event will default to the last date of the preceding 
cash flow line.  You can edit this date.

		  A Rate Change event will not affect the interest rate of the cash flow lines 
with dates prior to the date of the rate change.  The new rate will take effect 
on the date of the Rate Change cash flow line.

To enter a rate change event

	 1.	 From the Event field on a cash flow line, select Rate Change.

	 2.	 In the Rate Change dialog that appears, enter the new interest rate.  You 
can also edit the date of the rate change and compounding period.

		  To view or enter the effective annual, periodic, or daily rate, click the >> 
in the Rate Change dialog.  These rates are entered as described earlier in 
this chapter under Entering an Interest Rate.
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To change the compounding for a rate change

		  When you have a rate change, you can change the compounding.  This new 
compounding period will be in effect from the start date of the cash flow line 
and will not affect the cash flow lines that occur before it.

	 1.	 Display the Rate Change dialog from a Rate Change cash flow line.  You 
can do this by (a) clicking the far right of a Rate Change cash flow line, 
(b) right-clicking on a Rate Change cash flow line and selecting Rate 
Change, or (c) pressing F2 from a Rate Change line.

	 2.	 From the Compounding field, select the desired period.

		  The compounding period chosen here must be compatible with subse-
quent payment periods.  Compounding usually happens when payments 
occur.  It may also occur more frequently than payments, such as with 
daily compounding.  You cannot, however, combine a compounding 
period with payments that occur more frequently, such as Annual  
compounding with Monthly payments.  In addition, you can't mix  
week-based compounding with month-based payments.

		  The Daily, Exact Days, and Continuous compounding periods are 
compatible with any payment period.

	 3.	 Click OK to close the Rate Change dialog.

To enter a rate change with no compounding

	 1.	 Display the Rate Change dialog from a Rate Change cash flow line.  You 
can do this by (a) clicking the far right of a Rate Change cash flow line, 
(b) right-clicking on a Rate Change cash flow line and selecting Rate 
Change, or (c) pressing F2 from a Rate Change line.

	 2.	 From the Compounding field, select None.

	 3.	 Click OK to close the Rate Change dialog.

		  Choosing None for Rate Change compounding establishes a new interest 
rate effective on the event date but does not cause compounding.  When you 
choose None for the compound period, it only applies to the Rate Change 
event and does not affect the compound period of other cash flow lines.

		  You would usually use None for the compound period for loans where pay-
ments are regular but the interest rate changes at odd times based on market 
rates.  The overall compound period stays constant, and compounding is not 
triggered by interest rate changes.
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		  The top half of the Edit menu contains commands that are common to many 
Windows applications.  The Undo, Cut, Copy, and Paste commands work as 
described in the Windows User’s Guide.  These commands are primarily  
used to copy cash flow lines and edit headers, footers, and text fields.

		  You can quickly arrange the order of the cash flow lines with the commands 
in the lower half of the Edit menu.  The Insert Line and Delete Line com-
mands let you add or remove lines.  The Expand and Sort commands let you 
easily consolidate and organize cash flows.  To use these commands, you can 
select them from the Edit menu or tool bar.

		  The buttons in the middle of the tool bar carry out many of the same 
commands listed in the lower portion of the Edit menu.

Cut, Copy, and Paste Commands

		  You can use the Cut and Paste commands in the Edit menu to move the 
location of a cash flow line or move text in a text field.  To copy cash flows 
or text while leaving the original intact, use the Copy and Paste commands.  
You select lines to Copy or Cut by clicking on the number at the left of the 
line(s).

		  The Paste command puts the contents of the Clipboard into the active sched-
ule.  If a cash flow line is selected when Paste is chosen, the contents of the 
Clipboard will be placed before the selected cash flow line.  If no cash flow 
line is selected, then the cash flow lines from the Clipboard will be added to 
the end of the cash flow data.  If text is selected when Paste is chosen, the 
selected text will be replaced with the contents of the Clipboard.

Arranging Cash Flow Lines
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Inserting and Deleting Cash Flow Lines
		  The Insert Line and Delete Line commands let you add or remove lines 

from the Cash Flow Data window.  When you need to insert a cash flow line 
between two existing lines, use the Insert Line command from the Edit menu 
or click Insert on the tool bar.  This inserts a cash flow line that can then be 
edited.

To insert a cash flow line

	 1.	 Select a cash flow line by clicking the number at the left of the line.

	 2.	 Click Insert on the tool bar or choose Insert Line from the Edit menu.

		  A new line will be inserted above the selected line.  If no line was 
selected before the insert, then a new line will be added at the end of the 
cash flow data.  

		  The default event will depend on the events already used in the schedule.  
This new line will have an amount of 0 and number of 1.  Any subse-
quent cash flow lines will move down one row after the line is inserted.

	 3.	 Enter the needed information on this new cash flow line.

To delete a cash flow line

	 1.	 Click any field of the cash flow line you want to delete.

		  If you want to select multiple lines, click the number at the left of 
the line.  Use the Shift key to select a range of lines or Ctrl to select 
individual lines.

	 2.	 Click Delete on the tool bar or choose Delete Line from the Edit menu.

		  The selected line(s) will be deleted without affecting the remaining lines.  
Any subsequent cash flow lines will move up one row.
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Expanding and Sorting Cash Flow Lines
		  If you need to see the individual monthly payments of a 30 year loan, you can 

enter the payments as a series and let TValue software expand the cash flow 
line into 360 individual payments.  On the other hand, if your work requires 
that you enter individual cash flows, you can let TValue software sort them 
by date and consolidate them into a manageable series.

Expanding a Cash Flow Line

		  When you choose the Expand command, TValue software will expand the 
selected cash flow lines or all cash flows in the active schedule, and each cash 
flow line will represent a single event. 

		  For example, if you have a cash flow line that specifies a series of 36  
monthly payments and you choose the Expand command, 36 individual 
payment cash flow lines will be created one month apart.

Note    A TValue software schedule can contain up to 4,000 cash flow lines.  
This may limit your ability to expand all cash flows at once.  If so, expand 
and compress each series individually to avoid exceeding 4,000 lines.

To expand a cash flow series

	 1.	 Select the cash flow line to expand as shown below.  To select a cash  
flow line, click the number to the left of the cash flow.

		  If no line is selected, TValue software will expand all cash flows in the 
active schedule. 
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	 2.	 Click Expand on the tool bar or choose Expand from the Edit menu.

		  The cash flows in the schedule shown on the previous page will appear as 
shown below after choosing the Expand command.

		  If you do not like the results of the Expand command, choose Undo Expand 
from the Edit menu.
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Arranging Cash Flow Lines

Sorting Cash Flow Lines Chronologically

		  You can enter cash flows out of chronological order.  Cash flows are out of 
order when start dates overlap as shown below or when a start date overlaps 
with the end date on a prior cash flow line.

		  If you enter cash flows out of order, you can use the Sort command to sort 
and consolidate them into a manageable series.  

To sort all cash flow lines

	 1.	 Click Sort on the tool bar or choose Sort from the Edit menu.

		  The schedule shown above is shown below after clicking the Sort button.

  		  Note how the series of four cash flows is split to arrange all the cash flow 
lines in order.  This eliminates the overlapping of dates.  If two or more 
events occur on the same date, they will remain in the order they were 
entered in the schedule.
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		  In contrast to equal and regular payments or withdrawals, some schedules 
call for increases, decreases, skips, or even payment allocation to interest or 
principal.  TValue software will generate these types of payments or cash 
flow series through the use of the Special Series.  The Special Series can be 
used to generate interest only, percent step, amount step, skip payments, and 
others.

		  To enter a Special Series for a cash flow line, click the untitled column to the 
right of the cash flow line, or right-click the line and choose Special Series.  
You can also choose the Special Series command from the Compute menu.

		  If you prefer keyboard commands, you can access the Special Series dialog 
from the Amount field by pressing "S" or F2. 

		  Once you select a special series, it will be indicated in the far right column of 
the cash flow line.  If no words appear (as above) the series is normal.

	

		  Use the Special Series dialog to create a special series of payments, deposits, 
or withdrawals.  The special series options will apply only to the events on 
the cash flow line you are working on.  Any Special Series you have specified 
on other cash flow lines will be unaffected.

This indicates a Monthly 
Skip series

Creating a Special Series

Right-click anywhere on a line to display the 
drop-down menu and choose Special Series

Click this column to 
choose a Special Series

OR...



TValue Amortization Software Basics42

Creating a Special Series

Normal Payments
		  Normal payments are the most common type of payments.  A Normal pay-

ment series is used for payments or withdrawals that are the same amount 
each period.

		  Normal Payments are the default type of payment series.  When you enter 
payment amounts on the main screen, you are entering normal payments 
unless a special series is selected.  Click the far right column on a cash flow 
line to change from normal payments to a special series or to change from a 
special series back to normal payments.

To change back to normal payments

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Normal as the series.  The Normal dialog will appear.

	 3.	 Enter the payment amount in the dialog that appears.  Press U if you 
want to calculate the payment amount.

	 4.	 Select Activate normal payments for the currently highlighted event.

	 5.	 Click OK to close the dialog.

Interest Only
		  An Interest Only series is used to generate a series of cash flows equal to the 

amount of interest that has accrued since the last payment or withdrawal.  
TValue software will calculate the interest payment amounts.  Do not use this 
type of series if you wish to specify the amount of the payment.

To calculate payments that cover interest only

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Interest Only as the series.  The Interest Only dialog will appear 
as shown on the following page.
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	 3.	 Select Activate Interest Only series for the currently highlighted 
event.

	 4.	 Click OK to close the dialog.

		  The word "Interest Only" will appear in the Amount field on the Cash 
Flow Data window.

		  TValue software will automatically calculate interest only payment amounts 
when the amortization schedule is prepared.  After you select the Interest 
Only series as shown above and click OK, you can enter the number of 
interest only payments in the Number field on the Cash Flow Data window.

Fixed Principal + Interest
		  A Fixed Principal + Interest series generates a series of payments or 

withdrawals with a fixed amount applied to principal, plus an amount to 
cover accrued interest.  You can use the Fixed Principal + Interest series 
when setting up a new note that calls for payments of principal plus interest.

To enter payments with a fixed amount applied to principal

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Fixed Principal + Interest as the series.  The Fixed Principal + 
Interest dialog will appear.

	 3.	 Enter the amount to be applied to principal in the dialog that appears.  
Press U if you want to solve for the principal payment amount.

Creating a Special Series
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Creating a Special Series

	 4.	 Click OK to close the dialog.

		  After you close the dialog, the principal payment will be displayed in the 
Amount field on the Cash Flow Data window.  You can then enter the number 
of payments in the series in the Number field.  TValue amortization software 
automatically calculates the appropriate interest and adds it to each principal 
payment when the amortization schedule is prepared.

  Amount Step
		  An Amount Step series generates a series of amounts that increase or 

decrease by a fixed dollar amount after a specified number of payments.   
This is sometimes referred to as a dollar step series.

To enter payments that increase or decrease by a set amount 

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Amount Step as the series.  The Amount Step dialog will  
appear.

	 3.	 Enter the first payment amount in the Starting amount field.  If the 
amount is unknown, type U.

	 4.	 Enter the change amount in the Amount change per level field.  For 
example, if you want the payment amount to increase by $50 after three 
payments, enter 50 here.  If you want it to decrease, precede it with a 
minus (-) sign.   

The amount you want 
applied to principal
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	 5.	 Enter the number of payments that occur at each level.  For example, if 
you want three payments and then an increase, enter 3 in the Number 
made before change field.

	 6.	 Click OK when you are finished to close the dialog. 

		  After you close the dialog, the figure from the Starting amount field will be 
displayed in the Amount field on the Cash Flow Data window.  You can then 
enter the total number of payments in the series in the Number field.  TValue 
amortization software will automatically calculate the payment amounts 
when the amortization schedule is prepared.  

		  The series indicated above will create a series of payments that increase 
by $50 every third period.  The following series will be produced if nine 
payments are made.

			   700	 700	 700	 750	 750	 750	 800	 800	 800

Percent Step
		  In some financial arrangements, payments rise or fall each year.  These 

periodic increases are often due to a Cost of Living Adjustment (COLA).   
The Percent Step series accommodates these payments by generating a series 
of amounts that increase or decrease by a given percentage each year or after 
a specified number of payments or withdrawals.

Creating a Special Series

The first payment 
amount

The amount added to 
each payment each 
step

How many payments 
occur before it 
changes
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To enter payments that increase or decrease by a set percentage 

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Percent Step as the series.  The Percent Step dialog will appear.

	 3.	 Enter the first payment amount in the Starting amount field.  If the 
amount is unknown, type U.

	 4.	 Enter the percentage of each increase or decrease.  For example, if you 
want the payment amount to increase by 10 percent after three payments, 
enter 10 here.  For a decrease, precede the percent with a minus (-) sign.

	 5.	 Enter the number of payments that occur before each change.  For 
example, if you want 3 payments and then an increase, enter 3 in the 
Number made before change field.

	 6.	 Click OK when you are finished to close the dialog.

		  After you close the dialog, the amount from the Starting amount field will be 
displayed in the Amount field on the Cash Flow Data window.  You can then 
enter the total number of payments in the series in the Number field.  TValue 
amortization software will automatically calculate the payment amounts 
when the amortization schedule is prepared.  

		  The series indicated in the dialog above will create a series of payments 
that increase by 10 percent every third period.  The following series will be 
produced if nine payments are made:

			   1,000	 1,000	 1,000	 1,100	 1,100	 1,100	 1,210	 1,210	 1,210

Creating a Special Series

The beginning 
payment amount

The percentage 
of each periodic 
increase

The number of 
payments between 
each increase
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Monthly Skip
		  A Monthly Skip series generates a series that skips selected months.  This 

situation commonly occurs when you want to match payments or withdraw-
als with seasonal cash flow patterns.

To generate a series with regularly skipped monthly payments

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Monthly Skip as the series.  The Monthly Skip dialog will 
appear.

	 3.	 Enter the monthly payment amount (if known) in the Regular monthly 
amount field.  If the amount is unknown, type U.

	 4.	 Enter the amount to be made on skipped months in the Amount on 
"skipped" months field.  This amount is usually 0 but can be any amount 
you choose.

	 5.	 Select the months to skip during the series.  Click again on a month to 
de-select it.

	 6.	 Click OK to close the dialog.

		  After you close the dialog, the figure from the Regular monthly amount field 
will be displayed in the Amount field on the Cash Flow Data window.  You 
can then enter the total number of payments in the Number field.  Be sure to 
include skipped months in this total.

Creating a Special Series
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Skip Series
		  A Skip Series generates a series that skips certain payments, withdrawals, or 

deposits.  This situation usually occurs when you want to match payments or 
withdrawals with seasonal cash flow patterns.

To generate a series with regularly skipped payments

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Skip Series.  The Skip Series dialog will appear.

	 3.	 Enter the number of payments (or deposits or withdrawals) to make 
before the first skipped payment in the Number to make field.  For 
example, if you want to make three payments and then skip two, enter 3 
in this field.

	 4.	 Enter the regular payment amount in the Amount when made field.  If the 
amount is unknown, type U.

	 5.	 Enter the number of payments (or deposits or withdrawals) to skip in the  
Number to skip field.  For example, if you want to make three payments 
and then skip two, enter 2 in this field.

	 6.	 Enter the amount (if any) to be made on skipped periods in the Amount 
when skipped field.  This amount is usually zero.

	 7.	 Click OK when you are finished to close the dialog. 

Creating a Special Series
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		  After you close the dialog, the figure from the Amount paid when made field 
will be displayed in the Amount field on the Cash Flow Data window.  You 
can then enter the total number of payments in the series.  

		  The series indicated in the dialog on the previous page will create three regu-
lar 1,000 payments followed by two 0 payments.  The following series would 
be produced if eight payments are entered in the Number field on the sched-
ule:

	 1,000	 1,000	 1,000	 0	 0	 1,000	 1,000	 1,000

		  Use the Amount paid when skipped field in the Skip Payment dialog to enter 
an amount for skipped payments other than zero.  If you enter 50 in the 
Amount to Skip field, the following series will be produced:

	 1,000	 1,000	 1,000	 50	 50	 1,000	 1,000	 1,000

Existing Fixed
		  An Existing Fixed series is used to generate cash flows for an existing fixed 

principal or interest only series at any date in the life of the loan.  

		  Use this type of series to value an existing fixed payment to principal note at 
a different rate than that specified in the note.  It is also useful when you are 
discounting a series of interest only payments at a different rate.

Note    An Existing Fixed series is used to compute the value of an existing 
loan.  Do not use it to set up a new loan.  Use the Fixed Principal + Interest 
or Interest Only series (discussed earlier) for the original setup of a principal 
plus interest loan.

To generate cash flows from an existing fixed principal series

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Existing Fixed.  The Existing Fixed dialog will appear.

	 3.	 In the Note balance field, enter the balance that is remaining on the 
existing note.  This balance will be used to compute the interest for each 
period.

	 4.	 In the Rate for note field, enter the note rate.  This rate will be used to 
calculate the total payment amount. 

Creating a Special Series
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	 5.	 In the Principal payment field, enter the principal payment that will be 
made each period.  The total payment for each period is the combination 
of the entered principal amount and the computed interest for each payment.

	 6.	 Click OK when you are finished to close the dialog. 

		  After you close the dialog, the principal payment will be displayed in the 
Amount field on the Cash Flow Data window.  You can then enter the total 
number of payments in the Amount field.  TValue amortization software will 
automatically calculate the payment amounts when the amortization schedule 
is prepared.

		  TValue amortization software uses the note balance, principal payment, and 
rate for the note to generate the cash flows.  With five payments specified in 
the Number field, the following series will be generated:

			   1,050	 1,040	 1,030	 1,020	 1,010

Creating a Special Series
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Principal First
		  You can select Principal First payments to allocate payments towards princi-

pal first even if there is outstanding interest due.  This allocation of payments 
is only available with U.S. Rule (simple interest) amortization.

To allocate payments to principal

	 1.	 Click the far right untitled column on a cash flow line or right-click on 
the cash flow line and select Special Series.

	 2.	 Choose Principal First.  The Principal First dialog will appear.

	 3.	 Enter the payment amount in the Total payment amount field.  If the 
amount is unknown, type U.

	 4.	 Select Activate Principal First series for the currently highlighted 
events.

	 5.	 Click OK to close the Special Series dialog.

Creating a Special Series
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Entering Points and Fees for APR Calculations

		  For many loans, especially mortgages, there may be up-front charges that 
need to be included for purposes of computing the annual percentage rate 
(APR).  If points or other charges are included in a mortgage, the computed 
APR will be higher than the nominal annual rate.

		  You can enter charges in TValue software by clicking the right column of a 
loan cash flow line or by right clicking a cash flow line and choosing Points 
and Fees. The dialog for entering points and fees appears below.

		  The Points and Fees dialog can only be used with a loan event on the first 
cash flow line.  There can only be one loan with points and fees.

To enter points and fees for a loan

	 1.	 Click the far right untitled column of a loan cash flow line or right click a 
loan cash flow line and choose Points and Fees.

	 2.	 Enter the points, prepaid interest, and other changes in the Points and 
Fees dialog.

	 3.	 Click OK when you have entered all the loan charges.

		  The following are descriptions of the various fields in this dialog.

Amount of Loan

		  This field represents the amount of the loan without points, prepaid interest, 
or finance charges.  This is the same amount that is displayed in the Amount 
field of the cash flow line for the loan.  If you have not entered the loan 
amount, you can do so here.

The dollar value of points on loan

TValue software calculates this 
amount and uses it to compute 
the APR

The number of prepaid interest days
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Points Paid on Loan

		  This field displays the number of points charged on the original loan amount.  
Points are up-front charges generally computed as a percentage of the loan 
amount.  For example, if a $100,000 note is negotiated with “two points” or 
2 percent, as shown in the previous dialog, the lender will charge 2,000 as a 
finance charge.

		  Enter the number of points in the field.  TValue software will calculate the 
corresponding dollar amount from the number of points entered.  You can 
also enter the dollar amount and let TValue software calculate the number of 
points.

Prepaid Interest Days

		  This field is used to enter the number of days between the close of escrow 
and the date when the first interest period begins.

		  For example, if escrow closes on January 10 and payments start February 15, 
you would enter 5 in the Prepaid interest days field.  The payment due on 
February 15 would then include interest for exactly one month.  The interest 
for the five days from January 10 to January 15 will be counted as part of the 
total finance charge.

		  Enter the number of days in the field.  TValue software will calculate the cor-
responding dollar amount from the number of days entered.

		  TValue software will not allow you to enter payment dates that are within the 
prepaid interest period.  

Other Charges

		  This field is used to enter other charges that are required to get the loan.  
These charges are counted as part of the total amount financed that is used 
when calculating the APR for the loan.

		  Enter the total amount of other charges required to get the loan.

Amount Financed

		  The amount in this field is automatically calculated from the information in 
the other fields.  It is the amount of the loan, minus points, prepaid interest, 
and other finance charges.

Entering Points and Fees for APR Calculations
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Calculating an Annual Percentage Rate
		  TimeValue Software TValue amortization software will calculate the 

Annual Percentage Rate (APR) for the note and display it at the end of the 
amortization schedule for disclosure purposes.  The disclosure you see is in 
compliance with the specifications in Regulation Z.  It will appear as shown 
here (in reduced size):

		  You can choose to display or hide the APR calculation from the schedule.

To calculate and display the Annual Percentage Rate (APR)

	 1.	 From the Setup menu, choose Report Setup.

	 2.	 Select APR Information and click OK.

	 3.	 Enter the cash flow information for the problem and click the 
Amortization Schedule tab.  Adjust for rounding if needed.  The 
Amortization Schedule window will then be displayed.

	 4.	 Scroll to the bottom of the amortization schedule to see the APR 
disclosure information.

Entering Points and Fees for APR Calculations
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		  When provided with enough information, TValue software can compute an 
unknown value.  This unknown might include an interest rate, the loan or 
payment amount, or the number of payments.  You give TValue software the 
information you know and it does the rest.  TValue software takes into ac-
count all the relationships between amounts, dates, and interest rates.

		  If you don’t know the value of a particular variable, such as a payment 
amount, set it to Unknown by typing "U" in the field.  Only one type of field 
can be designated as unknown at a time.  If you don’t specify an unknown, 
but there is a discrepancy between the amount of the loan and the payments 
made, TValue software will calculate the remaining balance and display the 
choices you have for dealing with the leftover amount.  Usually, this discrep-
ancy can be resolved by changing the dates or amount of cash flows or by 
altering the interest rate.

		  After you compute an unknown, TValue software can restore the unknown(s) 
to allow you to change other variables and recompute if needed.  TValue 
software will also compute the balance on a loan as of a given date.

		  You can choose the commands to calculate and restore unknown values from 
the Compute menu or use the keyboard equivalents.  You can also compute 
unknowns by clicking Calculate on the tool bar.

		  The Compute menu also includes commands that let you specify loan charges 
for APR calculations.  This command is covered in detail in the TValue 
amortization software Basics chapter.

Calculating and Restoring Unknowns
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Calculating Unknowns
		  When TValue software calculates, it computes the value of any field that 

contains the entry "Unknown."  If no fields are designated as unknown when 
a calculation is performed, TValue software will determine if any balance 
remains unaccounted for.

		  The fields that can be designated as unknown include interest rate, amount, 
and number of events.  To enter an unknown, type U in one of these fields.  

		  Only one type of field can be designated as unknown at a time.  You can, 
however, designate more than one unknown amount or rate.  For example, 
you can designate multiple payment amounts as unknown in the same 
schedule.  You cannot, however, designate both a payment amount and the 
number of payments as unknown.

To calculate an unknown

	 1.	 Enter the information for the schedule you are working on.  Declare any 
unknown values as Unknown by typing U in those field(s).

	 2.	 Click Calculate on the tool bar or choose Calculate Unknowns from the 
Compute menu.  You can also press F9 or Ctrl+U to calculate.

		  The calculated value will replace the Unknown on the schedule.

Rounding Amounts
		  If any amount remains unaccounted for after computing, TValue software 

refers to it as a Rounding amount.  This amount will be displayed in the 
Rounding dialog.  If no unknown values exist when the Calculate command 
is chosen, any remaining balance, positive or negative, will be accounted for 
in the Rounding dialog.

To calculate and account for the rounding amount

	 1.	 From the Compute menu, choose Rounding, or click Rounding on the 
tool bar.

		  The Rounding dialog will appear as shown on the following page.

Calculating and Restoring Unknowns



Calculating and Creating Amortization Schedules58

		  Negative amounts, usually indicating an overpayment, are followed by a 
minus (-) sign.

	 2.	 Choose an option and click OK to adjust the rounding amount.  Click 
Cancel to return to the cash flow data without making any changes.

		  The choices in the Rounding dialog allow you to account for any rounding 
amount.  Descriptions of these fields follow.

		  Last Payment or Last Withdrawal    Applies any rounding amount to the 
last payment or withdrawal.  If the last payment is entered as part of a series, 
it will be placed on a separate cash flow line with the rounding amount added 
to or subtracted from it.

		  First Loan or First Deposit   Adjusts the first loan amount to eliminate the 
rounding amount.  This option may not entirely eliminate a rounding amount 
since you are adjusting the loan.  It may create a new rounding amount.

		  Balloon    Creates a new payment or withdrawal one period after the last 
event.  The amount of the event will equal the rounding adjustment plus any 
accrued interest for the period.

		  Specific Line    Adjusts the cash flow line you specify to eliminate the 
rounding amount.  It may create a new rounding amount.

		  Open Balance    Leaves the rounding amount as an open balance.  This 
balance will be shown on the amortization schedule.  You cannot do APR 
calculations if you select this option.

		  Ignore    Adjusts the last interest amount in the amortization schedule so that 
the balance equals zero. 
 

Calculating and Restoring Unknowns
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Restoring Unknowns
		  If you want to restore the unknown value(s) after calculating, you can choose 

the Restore Unknowns command from the Compute menu, or simply type U 
in the calculated field again.

To restore unknowns

	 1.	 From the Compute menu, choose Restore Unknowns, or press Ctrl+K.

Displaying a Totals Summary
		  After calculating, you can display a totals summary.  These totals include 

loans, payments, deposits, withdrawals, and interest.  If a rounding amount 
has been left as an open balance, the Totals window will display the amount 
of the open balance.  You can reconcile the balance by clicking Calculate.

Note    If the schedule you are working on contains loan charges for An-
nual Percentage Rate (APR) calculations, TValue amortization software can 
generate the disclosures you need for truth-in-lending requirements.  Com-
monly called a Reg Z disclosure, this summary is seen at the bottom of the 
amortization schedule if you have APR Information selected in the Report 
Setup dialog.

To display a totals summary

	 1.	 From the Compute menu, choose Totals, or click the Totals button on 
the Amortization Schedule tab.  The Totals dialog will appear as shown 
below.

		  The Totals dialog will display User event names if you have used them in 
the schedule.  If you want to summarize the User event totals into User 
Loan/Payment or User Deposit/Withdrawal categories only, you can 
select that option in the Report Setup dialog.

Calculating and Restoring Unknowns
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		  TimeValue Software TValue amortization software can calculate the balance 
on an investment or loan as of a given date.  TValue software will also calcu-
late the date when a certain balance is reached.

		  When you choose Balance from the Compute menu, the Balance dialog will 
appear.

		  Between payment dates, the balance is computed using a stub-period 
approach.  The stub-period approach is equivalent to removing all payments 
after the balance date and solving for a single unknown payment at that date.

		  For Rule of 78 computations, the balance is calculated using a prorated 
approach.  Refer to the TValue software Help for more information about this 
method.

To calculate a balance as of a particular date or the date when a 
specified balance is reached

	 1.	 Choose Balance from the Compute menu.

	 2.	 Enter the date or the amount of the balance.

	 3.	 Type U in the field you would like to calculate or leave the field blank.  

	 4.	 Click the Calculate button in the dialog and the date or balance will be 
calculated and displayed.

		  If the date you enter falls after the last cash flow, the Create Balloon but-
ton will be enabled.  If you click that button, TValue software will add a 
final payment or withdrawal, one period later, that will pay off the loan or 
withdraw the final balance.

	 5.	 To close the Balance dialog, choose Done.

Calculating a Balance or Balance Date
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Compute and Input Settings

 		  TValue software comes preset to handle the majority of financial calculations.  
You may never have to alter any of the standard settings for your work.  If, 
however, you work with calculations that vary from normal compound inter-
est, you will find that TValue software will accommodate most any situation.

		  Additional variables besides the compounding, interest rate, or loan and 
payment amounts may affect calculations in TValue software.  They include 
the compute method (Normal, U.S. Rule, Rule of 78, or Canadian) and the 
year length.  In TValue software, these variables are collectively referred to 
as the Compute Setup and can be changed to meet your requirements.

		  TValue software also lets you change input default settings.  These settings 
control the default compound period, event type, first payment default date, 
and default directory for File Save and Open.  These items are collectively 
referred to as the Input Setup.

		  The settings that initially appear in the Input Setup window are the default 
settings.  You can change these settings and save them as the new defaults by 
using the Save settings from ALL tabs as the default for new schedules 
check box at the bottom of the Setup window.

Compute Setup
		  When choosing Compute Setup from the Setup menu, TValue software 

displays a dialog of variables that affect how the product computes interest.  
When saving a TValue software file, the compute settings are included in the 
saved file.

		  The settings in the dialog pictured above are the default settings.
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To change the Compute Setup

	 1.	 From the Setup menu, choose Compute Setup.

		  The Compute Setup dialog will appear with the current settings.

	 2.	 Change settings by clicking on a field and choosing a selection from the 
drop-down menu that appears.

		  To save any changes to the Compute Setup (and other Setup windows) as 
default values for new schedules, select Save settings from ALL tabs as 
the default for new schedules.

	 3.	 Click OK when done or Cancel to ignore changes made in the dialog.  
The Reset button can be used to reset all the settings in the Setup dialogs 
to the original TValue amortization software defaults.

		  The settings in the Compute Setup dialog are described below.

Compute Method

		  The Compute Method controls how TValue amortization software computes 
interest.  Choose Normal (compound interest), U.S. Rule (simple interest - no 
compounding), Canadian, or Rule of 78.

		  To change the compute method, choose an option from the drop-down menu.  
The current method will be highlighted.

		  Normal (compound interest)    This is ordinary compound interest.  This 
method is also known as the actuarial method.  At the end of each compound 
period, the unpaid interest for the period is added to principal and becomes 
subject to interest in the following compound period.  Payments are applied 
first to interest and then to principal.

		  U.S. Rule (simple interest - no compounding)    With U.S. Rule, 
interest is never charged on interest.  Any unpaid interest is held as a separate 
non-interest bearing balance.  With U.S. Rule, you have the option to make 
payments to principal first even if there is outstanding unpaid interest.  The 
U.S. Rule compute method is often referred to as “simple interest.”

Compute and Input Settings
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Compute and Input Settings

		  Rule of 78    A method of allocating interest over time.  The total amount 
of interest on a loan is computed in advance.  This interest total is then 
considered earned in proportion to the periodic time balances.

		  Restrictions on use of Rule of 78:  Cannot be used with special series, such 
as fixed-principal + interest and percent step series.  Interest rate changes,  
multiple loans, open balances, or deposits/withdrawals are also not allowed.

 		  Canadian    Payments are generally made monthly or quarterly, but interest 
is usually compounded semiannually.  When producing an amortization 
schedule, an equivalent monthly rate of somewhat less than 1/6 the 
semiannual rate is used to apportion interest.  This is the only setting that 
allows compound intervals greater than the payment interval.

Year Length

		  The year length affects how TValue software computes the daily interest 
amount for exact days and daily compounding, and odd day periods.  To 
change the year length, click the Year Length field and choose an option from 
the drop-down list.  The current choice will be highlighted.

		  365    Choose 365 to compute daily interest for odd periods using 1/365 of 
the nominal annual rate.

		  364    Choose 364 to compute daily interest for odd periods using 1/364 of 
the nominal annual rate.  This method is useful when you are working with 
weekly payments and want your daily rate for stub periods to be exactly 1/7 
of the weekly rate.

		  360    Choose 360 to compute daily interest for odd periods using 1/360 of 
the nominal annual rate.  This method is useful when you are working with 
monthly compounding and want to treat odd days as 1/30 of a month.

Canadian Options

		  You can set the Canadian Options when you choose Canadian as the 
Compute Method.
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		  Canadian Basis    This determines the compounding or calculation basis. 
The Canadian Basis is either annual or semiannual.  Choose Annual to 
calculate interest on an annual basis.  Except for mortgages, the annual basis 
is used in nearly all cases.  Choose Semiannual to compute interest on a 
semiannual basis.  This is commonly used for Canadian mortgages.

		  Odd Days    This setting controls the calculation of interest for odd days 
or stub periods.  The Straight-line method computes interest for each day 
without compounding.  This is similar to exact days compounding.  The 
Compounded method compounds interest for each odd day.  This is similar  
to daily compounding.

Input Setup
		  When you choose Input Setup from the Setup menu, the Input Setup dialog 

displays the input defaults.  Use this dialog to specify defaults, such as 
compound period, event type, date, or default save and open directory.

		  The settings in the dialog pictured above are the default settings.

To change the Input Setup

	 1.	 From the Setup menu, choose Input Setup.

		  The Input Setup dialog will display the current settings.

	 2.	 Select the options you want.

Compute and Input Settings
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		  To save any changes to the Input Setup (and other Setup windows) as 
default values for new schedules, select Save settings from ALL tabs as 
the default for new schedules.

	 3.	 Click OK when done or Cancel to ignore changes made in the dialog.  
The Reset button can be used to reset all the settings in the Setup dialogs 
to the default settings that are originally shipped.

		  The settings in the Input Setup dialog are described in detail below.

Compounding

		  This setting determines the compounding period that will appear when 
starting a new schedule.  Select the desired period from the drop-down menu.

Event

		  This setting determines which event will appear on the first cash flow line of 
a new schedule.  If you choose Loan, the default event for the first cash flow 
line will be Loan, and subsequent cash flow lines will default to Payment.  
If you select Deposit, the default event for the first cash flow line will be 
Deposit, and later lines will default to Withdrawal.  If you select User Loan 
or User Deposit, they operate in the same fashion as described for Loan and 
Deposit, respectively.

Date of second cash flow line

		  This setting determines whether the default date of the second cash flow line 
is in advance or arrears on a new TValue software schedule.

		  One period after first cash flow line    Select this option if you want 
the first payment or withdrawal date to default one period after the loan or 
deposit - commonly known as "in arrears."  This is the default choice for 
most loans and mortgages.

		  Same date as first cash flow line    Select this option if you want the 
first payment or withdrawal date to default to the same date as the loan or 
deposit on the first cash flow line.  This is the choice for a payment that is 
made "up front" or "in advance."  This default is common for leases.
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Whole Dollar

		  The Whole Dollar setting determines if amounts are entered as whole 
amounts (i.e., no cents). 

		  If selected, all entered amounts will be rounded and displayed to the nearest 
dollar amount.  For example, if you enter 100 or 100.49, you get 100.  If you 
enter 100.50, you get 101.  In most cases you will not need to use the Whole 
Dollar mode.  This mode is useful when amounts are over 100,000,000 and 
cents are just a distraction.

Show warning if line one has multiple loans

		  When this is selected, TValue amortization software will notify you if you 
have more than one Loan on the first cash flow line.  Many first time users 
make the mistake of entering the number of payments there.  Experienced 
TValue software users may want to turn this option off.

Default Directory (for File Open and Save)

		  This setting determines the directory that TValue amortization software will 
display for saving and opening files.  

		  Click the Browse button and select the drive and directory or type the path 
directly.

		  To save this directory as the default for future sessions of the software, select  
Save settings from ALL tabs as the default for new schedules from the 
bottom of the Setup window before clicking OK.

Compute and Input Settings
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		  After you calculate for any unknowns in TValue software, you can produce 
an amortization schedule.  This schedule displays details about the interest 
and principal components of the events.

		  The amortization schedules produced will vary depending on the type of 
events you are working with.  TValue software automatically chooses be-
tween reports that show loans/payments and reports that show deposits/with-
drawals.  If you have multiple loans in a single schedule, the format is also 
automatic.

		  The contents of the report, such as when to show totals or whether to display 
the interest rate can be controlled.  A sample amortization schedule is shown 
here as it would appear on your screen.

		  The buttons along the top of the Amortization Schedule window give you 
quick access to setup options, headers and footers, fonts, and even exporting 
to Microsoft Word and Microsoft Excel. 

Displaying and Printing an Amortization Schedule
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Displaying an Amortization Schedule
		  TimeValue Software TValue amortization software lets you see what the 

amortization schedule looks like on your screen before you print.  You must 
first compute any unknowns to view an amortization schedule. 

To display an amortization schedule on the screen

	 1.	 After entering all the information in the Cash Flow Data window, click 
the Amortization Schedule tab or press F4.

	 2.	 If the Rounding dialog appears, choose an option and click OK.

		  The amortization schedule will display on the screen.

	 3.	 To return to the Cash Flow Data window to make changes, click the 
Cash Flow Data tab or press F4.

Printing an Amortization Schedule
		  You can print an amortization schedule at any time.  It is not necessary to 

display the amortization schedule on your screen before printing.

To print an amortization schedule

	 1.	 After entering all the information in the Cash Flow Data window, click 
the Print button or choose Print from the File menu.  It is not necessary 
to have the Amortization Schedule window displayed to print an 
amortization schedule.

	 2.	 If the Rounding dialog appears, choose an option and click OK.

	 3.	 Click Print on the tool bar or choose Print from the File menu.

		  The Print dialog is displayed.  The information in the dialog is determined 
by the printer driver that you are using and may vary from printer to 
printer.  To change the default settings that appear here, choose Print 
Setup from the File menu.

	 4.	 Choose the Printer and Print Range.  Enter the number of copies to print.  

	 5.	 Click OK to begin printing the amortization schedule or click Cancel to 
close the Print Dialog and return to TValue amortization software.

Displaying and Printing an Amortization Schedule
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		  You can export the contents of an amortization schedule so you can use it 
in other applications.  Once exported, these files cannot be read or imported 
back into TValue software.  To have the data available for future modification 
in TValue software, you should first save it as a TValue software file.

		  When you export files to a spreadsheet program like Excel, the files created 
contain no calculation formulas

Exporting an Amortization Schedule to Word or Excel
		  If you have Microsoft Excel or Word (Version 97 or above) you can auto-

matically export the amortization schedule information to both these appli-
cations.  Excel and Word give you additional flexibility for displaying and 
printing schedules.

Note    The automatic export feature is not compatible with versions prior 
to Excel 97 or Word 97.  If you are using Microsoft Word 95 or Excel 95, 
or a word processor or spreadsheet application from another manufacturer, 
you can save the amortization schedule to a file that you can edit with your 
application.

To automatically export an amortization schedule to Microsoft 
Word or Excel

	 1.	 After entering all the information for a schedule in the Cash Flow Data 
window, click the Amortization Schedule tab or choose Amortization 
Schedule from the Compute menu.

	 2.	 If the Rounding dialog appears, choose an option and click OK.

	 3.	 Click either the Send to Word or Send to Excel button.  Microsoft Word 
or Microsoft Excel will automatically start and a new document will be 
created in the application for the exported schedule.  This process may 
take a few moments. 

Exporting an Amortization Schedule
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Exporting an Amortization Schedule to a File
		  You can save the amortization schedule from TValue software in a file format 

of your choice.  This file can then be opened for use in other applications.

To export an amortization schedule to a file

		  An exported amortization schedule cannot be read by TValue software.  Save 
a copy of the TValue software file with the Save command if you need to edit 
it in TValue amortization software.

	 1.	 Choose Export Schedule from the File menu.  Select the file type from 
the Export Schedule dialog and click OK.

		  All the information entered on the amortization schedule, including 
special series and points and fees information, will be exported.

	 2.	 Type a name in the File Name field of the Save As dialog.  TValue soft-
ware will add the appropriate three-character extension to your file name 
when you save it.

	 3.	 Select the location of where you want to save the file and click OK.

Exporting an Amortization Schedule to XML

		  You can save the amortization schedule from TValue software as an XML 
document.

		  For more information about creating an XML document with TValue soft-
ware, contact TimeValue Software at 1-949-727-1800, 1-800 426-4741, or 
support@TimeValue.com.

To export an amortization schedule to XML

	 1.	 Choose Export Schedule from the File menu.

	 2.	 Select XML as the file type from the Export Schedule dialog and click 
OK.

	 3.	 Type a name in the File Name field of the Save As dialog.  TValue soft-
ware will add the ".xml" extension to your file name when you save it.

	 4.	 Select the location of where you want to save the file and click OK.
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		  The Report Setup dialog indicates which items and totals are included on the 
amortization schedule.

		  When you create a new TValue software schedule, the settings that appear 
in the Report Setup dialog are the default settings.  You can change these 
settings and save them as the defaults for new schedules by selecting "Save 
settings from ALL tabs as the default for new schedules" at the bottom of the 
Setup window.  Each schedule stores its own report setup.  The values can be 
different from one schedule to the next.

To change the Report Setup

	 1.	 From the Setup menu, choose Report Setup.

		  The Report Setup dialog will display the current settings. The default 
settings in the Report Setup dialog are shown below.

	 2.	 Select the options you want.

		  To save any changes to the Report Setup (and other Setup windows) as 
default values for new schedules, select Save settings from ALL tabs as 
the default for new schedules.

	 3.	 Click OK when done or Cancel to ignore changes made in the dialog.  
The Reset button can be used to reset all the settings in the Setup dialogs 
to the original TValue amortization software defaults.

Changing the Report Setup
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Information to Include

		  The Information to Include check boxes in the Report Setup dialog let you 
specify which items will be included on the amortization schedule.

		  Date    Places the system date at the top of the amortization schedule.

		  Time   Places the current time at the top of the amortization schedule.

		  Label     Prints the text from the Label field at the top of the amortization 
schedule.  If you add a header to the schedule, the label will print below the 
header.

		  Compounding    Includes the compound period on the first page of the 
amortization schedule.

		  Page Break before Amortization    Forces a page break between the last 
line of the cash flow information (compound period, rates, and cash flow 
data) and the amortization detail.  The amortization schedule starts on a new 
page.

	 	 Totals Only    Includes only the selected totals on the schedule.  The 
individual details of the loans, payments, and other events will not be 
included on the report when this option is selected.

		  Quarterly Totals    Includes quarterly totals on the amortization schedule.

		  Annual Totals    Includes annual totals on the amortization schedule.

		  You can change the fiscal year-end month to change the annual total 
breaks.  For example, a March fiscal year-end will show the annual totals 
after the March activity.  Use the Fiscal Year-end setting in this dialog.

		  Grand Totals    Includes grand totals on the amortization schedule.

		  APR Information    Controls whether an annual percentage rate (APR) 
summary is printed on the amortization schedule.  If selected, the summary 
prints at the end of the schedule on a separate page.  If an open balance 
occurs in the TValue software schedule, "Undefined" will appear in the APR 
field on the schedule.

Rate Information to Include

		  The Rate Information check boxes in the Report Setup dialog let you specify 
the interest rate information included in the report.

		  Nominal Rate    Includes the nominal annual rate on the first page of the 
amortization schedule.
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		  Effective Rate    Includes the effective annual rate on the first page of the 
amortization schedule.

		  Periodic Rate    Includes the periodic rate on the first page of the amortiza-
tion schedule.

		  Daily Rate    Includes the daily rate on the first page of the amortization 
schedule.

		  Rate Changes    Includes rate change events on the amortization schedule.

User Event Columns

		  If you are using user event names, select this option to combine the user 
events into two columns on the amortization schedule.  If this option is not 
selected, the user events that are used in the cash flow data window will be 
displayed in individual columns on the amortization schedule.

Fiscal Year-end

		  When you include quarterly and annual totals on an amortization schedule, 
TValue software defaults to show these totals based on a calendar year-end (e.g., 
December).  You can choose to display these totals based on a different fiscal 
year-end.

Rounding Message

		  If any amount remains unaccounted for after computing, TValue amortization 
software refers to it as a Rounding amount.  If this amount is unaccounted for 
before printing an amortization schedule, it will be displayed as a Rounding 
message on the schedule.  If you have chosen to leave an open balance after 
computing, the rounding message will reflect this.

		  The Rounding Message buttons in the Report Setup dialog let you specify the 
placement or omission of the rounding message on the amortization schedule.

		  End of Report    Prints the rounding message at the end of the last page of 
the amortization schedule.

		  Separate Page    Prints the rounding message on a separate page.

		  None    Omits the rounding message from the amortization schedule.
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Cash Flow Data

		  The cash flow data is the information you entered in the Cash Flow Data 
window of a TValue software schedule.  The information includes events, 
dates, amounts, etc.  The Cash Flow Data buttons let you specify the 
placement or omission of the cash flow data on the amortization schedule.

		  Start of Report    Prints the cash flow data before the amortization 
information, normally on the first page of the report.

		  End of Report    Prints the cash flow data after the amortization 
information.

		  None    Omits the cash flow data from the amortization schedule.

Header & Footer

		  A header is descriptive text that prints at the top of the first page of the 
amortization schedule.  A footer is descriptive text that prints in the bottom 
margin of each page on an amortization schedule.  For example, you could 
include a company name and address in a header, and information about the 
preparer of the report in the footer.

		  You can create or retrieve a header and footer for the active schedule by 
clicking the Headers & Footers button in the Report Setup dialog or on the 
Amortization Schedule window.  The Header & Footer dialog will appear.

		  If one header or footer is common to most of the schedules you produce, you 
can create a default header and footer setup that automatically applies to new 
schedules.
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		  Use the Template A and Template B to store two headers and two footers 
that you can retrieve instead of typing in a new header for each report.  You 
can change the stored headers and footers by clicking on Edit Templates.

		  The Alignment field and Font button on the Header & Footer dialog let you 
control the position and appearance of the header and footer on the report.

		  Select Show On Report to include the displayed header and footer on the 
amortization schedule.

Fonts

		  Click the Fonts button from the Report Setup dialog to open the Fonts 
dialog.  From this dialog you can change the font and style of the text on 
reports.   This determines how characters appear on the screen and in print.

Margins

		  Margins are the space around the edges of the page where nothing is printed.  
In general, the amortization schedule appears in the printable area inside the 
margins.  Use the Margins settings to determine how much empty border you 
want when the amortization schedule is printed.  The Margin settings do not 
effect how the schedule is displayed in the Amortization Schedule window.

		  Click the Margins button in the Report Setup dialog to open the Margins 
dialog where you can specify the width of the margins around the page.  The 
margins you select will apply to all pages of the current schedule.

Report Range

		  Click the Report Range button from the Report Setup dialog to display 
the Report Range dialog where you can specify the first and last date you 
want included on the amortization schedule.  The periodic totals (quarterly, 
annually, etc.) shown on the report will display amounts for the time period 
selected.
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		  Background    Normal amortization, functionally known as compound or 
actuarial amortization, computes interest at the end of every compound 
period.  If a payment is received at that point, it is applied first to interest and 
then to principal.  If not all of the interest for the compound period is paid, 
the unpaid interest is added to the principal and becomes part of the basis for 
calculating the interest due for the next compound period.

		  Facts    Miller Equipment Co. sells machinery to Wendland on June 11, 
2007, for $27,000.  They allow a trade-in of $4,000 on used equipment and 
take a 9 percent note calling for 28 equal monthly payments beginning 
August 3, 2007.

		  Needed    The monthly payment amount.

		  Settings    This example assumes Normal amortization, 365 day year.

	 1.	 Enter the information as shown below.

		  You could have subtracted the 4,000 trade-in from the initial loan amount 
to arrive at a 23,000 loan amount.  You then could have omitted the pay-
ment on line 2.

	 2.	 Click Calculate on the tool bar to compute the payment amount.

		  Solution    The monthly payment will be 918.72.

Monthly Payment Amount
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		  Facts    Samuel borrows $100,000 from Kingston Finance on November 
24, 2007.  The loan bears interest at 7.29% and calls for 120 equal monthly 
payments beginning December 24, 2007.  Samuel plans to pay off the 
remaining balance with a balloon payment after 60 payments

		  Needed    The monthly payment amount and the balloon payment amount.

		  Settings    This example assumes Normal amortization, 365 day year.

	 1.	 Enter the information for the original loan as shown below.

	 2.	 Click Calculate on the tool bar to calculate the payment amount.

		  The monthly payment based on a 10 year (120 months) amortization is 
1,176.09.

	 3.	 Change the number of payments on line 2 from 120 to 60.  This repre-
sents the number of payments made before the balloon payment.

	 4.	 Enter a payment for an unknown amount on the date of the balloon as 
shown below.

	 5.	 Click Calculate on the tool bar to calculate the balloon payment amount.

		  Solution   The payment amount amortized over 120 months is 1,176.09.  
The balloon payment on November 24, 2012 will be 58,985.98.

Loan With Balloon Payment
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		  Facts    Consolidated Equipment is providing financing for Kennamer, who 
is purchasing a $185,000 harvester on March 1, 2007.  The down payment is  
$30,000 and the nominal annual interest rate is 7 percent.  The loan is to 
be paid in equal monthly installments over a five-year term, with payments 
beginning April 15, 2007.  To accommodate Kennamer’s seasonal cash flow 
problems, no payments are due in January, February, or March.

		  Needed    The monthly payment for the months when payments are made.

		  Settings    This example assumes Normal amortization, 365 day year.

	 1.	 Enter the information as shown here:

	 2.	 Right-click anywhere on the second cash flow line and choose Special 
Series.  Choose Monthly Skip as the type of series.  Enter the skip 
payment information in the dialog as shown below.

Monthly Skip Payment Loan
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	 3.	 Click OK when you are finished with the dialog.

		  The right column of the Cash Flow Data window will display “Monthly 
Skip” to indicate the Skip Payments.

		  Your schedule should look like this:

	 4.	 Click Calculate on the toolbar.

		  Solution    The monthly payment will be 4,067.95.

		  Comment    The amortization schedule will show payments of 0.00 in Janu-
ary, February, and March of each year to represent the skipped payments.

Monthly Skip Payment Loan
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		  Background    The event names and weighted unknown features in TValue 
amortization software, version 5 are particularly useful for leasing scenarios.  
You can label the various events for commission, first and last payment, 
residual, and other nonstandard events.  You can use weighted unknowns to 
easily calculate the amount of two unknown advance payments.  Both these 
features are illustrated in the  following example.

		  Facts    Cirrus Industries leases a printing press with a fair market value of 
$168,440 to Martel Printing on July 1, 2007.  Terms of the lease call for two 
payments to be made at inception followed by 58 monthly payments.  The 
annual interest rate is 8.29%.  The payments are to be calculated assuming a 
20% residual at the end of the lease term of $33,688.

		  Needed    The monthly payment amount.

		  Settings    This example assumes Normal Amortization, 365 day year.

		  First, create event names called Lease, Lease Payment, and Residual to use in 
this problem.

	 1.	 Press F8 or right-click the first cash flow line and select Event Names.  

	 2.	 Select the Loan and Payment User events.  Enter Lease as User Loan 
Name 1, Lease Payment as User Payment Name 1, and Residual as 
User Payment Name 2.  These event names are the default names and 
can also be reset by clicking the Reset button in the Event Names window.  
The Event Names window will look like this:

		  If you would like these events to be available for schedules in the future, 
check Save settings from ALL tabs as the default for new schedules.	

Lease Payment With Residual
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	 3.	 Click OK to close the Event Names window.

		  You can now choose Lease, Payment and Residual as events.

	 4.	 From the Setup menu, choose Input Setup or press F5.

	 5.	 Select Same date as first cash flow line for the Date of second cash flow 
line setting.

	 6.	 Click OK to close the Input Setup window.

	 7.	 Enter Martel Printing press lease in the Label field.  Choose Monthly as 
the compounding and enter 8.29 as the Nominal Annual Rate.

	 8.	 On the first cash flow line, choose Lease as the event, type 070107 as the 
date, and enter the amount of 168,440.

	 9.	 On the second cash flow line, choose Lease Payment as the event, be sure 
the date is 07/01/2007, and type 2x in the Amount field.

		  Your screen will look like this:

		  The 2.000x in the Amount field represents the two unknown payments 
at the lease inception.  (The use of weighted unknowns such as 2x are 
described more on page 31.)

	 10.	 Enter the remaining information for the lease as shown on the following 
page.

Lease Payment With Residual
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	 	 Note    Notice the date of the Residual on line 4 has been advanced two 
months to occur at the end of the lease term since two payments were 
taken upon inception.  This date may vary for your situation.

	 11.	 Click Calculate on the tool bar to calculate the payment amount.

		  Solution    The monthly payment is 2,943.36.  Two payments up front total 
5,886.72.

Lease Payment With Residual
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		  Facts    Christopher is considering leasing a new automobile through PML 
Leasing.  The fair market value of the automobile in October 15, 2007 is 
$35,948.40.  The lease calls for $5,008.83 due on the date of the lease and 60 
monthly payments of $401.06 beginning November 15, 2007.  The estimated 
value of the vehicle at the end of the term (October 15, 2012) is $19,411.92.

		  Needed    The rate (implicit rate) on the lease.

		  Settings    This example assumes Normal Amortization, 365 day year.

		  First, create events called Lease, Lease Payment, and Residual to use in this 
problem.

	 1.	 Press F8 or right-click the first cash flow line and select Event Names.  

	 2.	 Select to include the Loan and Payment User events.  Enter Lease as 
User Loan Name 1, Lease Payment as User Payment Name 1, and 
Residual as User Payment Name 2.

		  These event names are the default names and can also be reset by 
clicking the Reset button in the Event Names window.

	 3.	 Click OK to close the Event Names dialog.

		  Lease, Lease Payment, and Residual should now be available as choices 
from the Event field.

	 4.	 Enter the lease information as shown below.

		  Notice that in this example the date of the Residual is the same as the end 
date of the lease payments.

	 5.	 Click Calculate on the tool bar.

		  Solution    The implicit rate on the lease is 9.742 percent.

Implicit Rate on a Lease
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		  Facts    Santos accepts a note from Kelley in payment for his business.  The 
note, dated September 5, 2007, has a face amount of $500,000.  Monthly 
interest only payments at 9 percent start October 1, 2007 and continue 
through July 1, 2012 (58 payments).  The remaining balance is to be paid off 
in 60 regular monthly payments beginning August 1, 2012.

		  Needed    The amount of the interest only and regular monthly payments.

		  Settings    This example assumes Normal amortization, 365 day year.

	 1.	 Enter the information on the first two cash flow lines as shown below.

	 2.	 Click the far right untitled column of the second cash flow line and select 
Interest Only as the series.  Click OK to exit the Special Series window.

	 3.	 On the third cash flow line, choose Payment as the event and enter 
080112 as the date.  Enter U for unknown in the Amount field.

	 4.	 Enter 60 in the Number field and choose Monthly as the period.

	 5.	 Click Calculate on the tool bar then click the Amortization Schedule tab.

		  Solution    The payment during the payoff phase is 10,379.18.  The interest 
only payment amounts will display on the amortization schedule.

Interest Only and Normal Payments



Common Examples 87

		  Background    A common present value calculation is to compute the 
current value of the remaining payments in a payment stream.  To do so with 
TValue amortization software, you first enter a loan with an unknown amount 
on the present value (valuation) date, then enter payments remaining after 
that date.  When you are calculating a present value, only the cash flows 
that remain are used in the calculation.  Those that have already occurred 
are not considered.

		  This method is useful for discounting a mortgage or trust deed.  You can use 
these steps to determine what to pay for a note in order to receive a predeter-
mined yield on the investment.  These steps are also useful for determining 
the value of a structured settlement.

		  Facts    Fleury holds a note from Applegate calling for the payment of 
$5,000 per year for seven years beginning January 17, 2008.  A final payment 
of $3,284.39 is due January 17, 2014.  Fleury plans to sell his note to 
Lockwood on September 5, 2007.  The note is to provide an annual yield of 
15.5 percent to Lockwood.

		  Needed    The value of the note at September 5, 2007.

		  Settings    This example assumes Normal Amortization, 365 day year.

	 1.	 Enter the information as shown below.  Note that only the payments 
remaining after the valuation date of September 5, 2007 are important.

	 2.	 Click Calculate on the tool bar to compute the value of the remaining 
payments on September 5, 2007.

		  Solution    The calculated loan amount of 21,712.19 represents the present 
value of the remaining payments on September 5, 2007.  Fleury should sell 
the note to Lockwood for this amount to yield 15.5 percent.

Present Value of an Existing Note
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		  Background    In this example, we will show you the difference between a 
30-year conventional loan and two methods of paying off the loan faster by 
making additional principal payments.

	 	 Scenario One    We will solve for the payment on a 30-year mortgage.

		  Scenario Two    We structure a biweekly mortgage.  We will take the 
payment amount from the 30-year mortgage and divide the monthly payment 
in half.  This amount will be paid biweekly (every two weeks).  

		  Making biweekly payments is a popular way of cutting the term of a mort-
gage.  Since there are 26 biweekly periods in a year, you end up making the 
equivalent of one extra payment each year (26 biweekly half payments is the 
same as 13 regular monthly payments).

		  Scenario Three    We will make monthly payments with a small addition 
to our regular monthly amount.  The additional monthly amount will be 
equal to one monthly payment divided by 12.  This method will accelerate 
the paydown of the mortgage, similar to a biweekly plan, but with fewer 
individual payments.

		  Scenario One Facts    Azevedo borrows $275,350 on July 1, 2007 to buy 
a new home.  The loan calls for 360 monthly payments starting August 1, 
2007.  The annual interest rate is 7.125%.

		  Needed    The monthly payment amount and the total interest that will be 
paid over the 30-year term.

	 	 Settings    This example assumes Normal Amortization, 365 day year.

	 1.	 Enter the information for the loan as shown below.

	 2.	 Click Calculate on the tool bar to compute the monthly payment amount.  
The monthly payment on this 30-year loan is 1,855.08.

Accelerated Paydown of a Mortgage
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	 3.	 From the Compute menu, select Totals.  TValue amortization software 
will display the following totals:

		  Solution    If you make all 360 payments of 1,855.08, you will end up 
paying 392,478.80 in interest over the term of the loan.

		  Scenario Two    Dividing the monthly payment on a 30-year mortgage in 
half and using that amount to make biweekly payments is a popular way of 
cutting the term of the mortgage.  Since 26 half-payments (13 full payments) 
are made instead of 12 full payments, the loan will be paid off faster.  So, the 
reason a biweekly loan works, stems from the fact that one extra payment is 
made each year.

	 	 Scenario Two Facts    Take the monthly payment for the Azevedo loan of 
1,855.08 and divide that payment in half.  The biweekly payment works out 
to be 927.54 (1,855.08 / 2).

		  Needed    The new term of the loan and the total interest that will be paid 
on the loan.

	 1.	 Enter the biweekly mortgage payment information as shown below.

		  Notice that the compounding is changed to Biweekly and an unknown has 
been entered for the number of payments.  	

Accelerated Paydown of a Mortgage
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Accelerated Paydown of a Mortgage

	 2.	 Click Calculate on the tool bar to compute the number of biweekly pay-
ments.

	 3.	 From the Rounding dialog that appears, select Balloon and click OK.

	 4.	 From the Compute menu, select Totals.  TValue amortization software 
will display the following totals:

		  Solution    The Biweekly loan will be paid in full on January 12, 2031.  The 
term of the loan will reduce from 360 months (30 years) to 614 biweekly 
payments (23.62 years).  The total interest paid on the biweekly loan will be 
293,852.54.

		  Scenario Three    Making an additional principal payment with the regular 
monthly mortgage payment will save interest and reduce the term of a 
mortgage.  TValue software will automatically apply the additional payment 
amount to principal.

		  Scenario Three Facts    Take the monthly payment for the Azevedo 
loan of 1,855.08 and divide that payment by 12.  The result is 154.59.  We 
will add that amount to the regular monthly payment of 1,855.08.  The total 
monthly payment will then be 2,009.67.

		  Needed    The new term of the loan and the total interest that will be paid 
on the loan.

	 1.	 Enter the additional principal payment information as shown below.
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	 2.	 Click Calculate on the tool bar to compute the number of monthly 
payments.

	 3.	 From the Rounding dialog that appears, select Balloon and click OK.

	 4.	 From the Compute menu, select Totals.  TValue amortization software 
will display the following totals:

		  Solution    The additional principal payment loan will be paid in full on 
March 1, 2031.  The term of the loan will be reduced from 360 monthly 
payments (30 years) to 284 monthly payments (23.67 years).  The total 
interest paid will be 294,761.00.

		  Summary	                        Total Interest	         Loan Payoff Term

		  30-year mortgage	 392,478.80	 30 years*

     		  Biweekly mortgage	 293,852.54	 23.62 years*

		  Additional principal	 294,761.00	 23.67 years*
		  mortgage

		  * The annual payments on the 30-year mortgage are 22,260.96 (1,855.08 x 
12).  The annual payments on both the biweekly mortgage and additional 
principal mortgage are 24,116.04.

Accelerated Paydown of a Mortgage
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		  Background    There are many ways to evaluate the performance of an 
investment.  The most common is the Internal Rate of Return (IRR) calcula-
tion.  The IRR is the annualized yield calculated from a series of cash flows.  
The TValue amortization software IRR is represented by the calculated 
Nominal Annual Rate.

		  Facts    Alexander Oil is planning on building a new derrick in the Alaskan 
Wilderness at a total cost of $30,000,000.  This amount must be paid by 
January 2, 2007.  The estimated yearly cash flows from the oil obtained is 
$4,500,000 per year for the first ten years, $3,000,000 per year for the second 
ten years, and $2,000,000 per year for the third ten years.  They plan on 
selling the project for $10,000,000 on January 2, 2038.

		  Needed    The IRR on the estimated cash flows.

		  Settings    The problem asumes Normal Amortization, 365 day year.

		  1.	 Enter the cash flow information as shown below.

	 2.	 Click Calculate on the tool bar to compute the Nominal Annual Rate.

		  Solution    The Nominal Annual Rate displays the IRR of 13.208%.

		  What If?    What would the final selling price have to be for a 13.3% return?

	 1.	 Change the Nominal Annual Rate to 13.3%.

	 2.	 Type U for the final Return amount on line 5.

	 3.	 Click Calculate on the tool bar.

		  Solution    To get a 13.3% return, Alexander Oil would need to negotiate a 
final selling price for the project of 17,983,269.10.

Return on Investment
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		  Background    One of the most common questions asked of Financial 
Planners is, “How much money will I have in the future?”  Future value 
calculations with TValue amortization software provide a way to answer that 
question.

		  Facts    P. Pincher has managed to save $1,000.  He is going to deposit that 
money in a savings bond yielding 5%, on July 10, 2007.  He would like to 
know how much that investment will be worth in 25 years.

		  Needed    The balance on July 10, 2032.

		  Settings    This example assumes Normal Amortization, 365 day year.

	 1.	 Enter the following cash flow information.

		  Solution    The amount available for withdrawal on July 10, 2032 is 
3,386.35.

		  Proof    P. Pincher is a skeptical man.  He does not believe that he can more  
than triple his money over that time period using such a modest growth rate.  
He would like to see the details of the interest accruals during the time 
period.  

	 1.	 Click on line 3 of the existing schedule to create a new cash flow line.  
Enter the information as shown below.  Click OK when asked if you 
would like to temporarily suspend date checking.

	 2.	 Click Sort on the tool bar.

Future Value
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	 3.	 Click the Amortization Schedule tab to display the amortization of the 
withdrawal amounts.

		  You will notice that for each of the 0.00 withdrawals, TValue amortization 
software displays the amount of interest calculated since the last withdrawal 
date.

Caution    It is possible to alter calculations by inserting 0.00 payments on 
dates other than regular payment dates.  The 0.00 payments can cause 
compounding of interest on the odd days.  In this case, the calculation was 
not altered by inserting the 0.00 payments because these payments occurred 
on the same date as the annual compound.  For more details, see “Odd-days” 
in the TValue amortization software on-line help.

Future Value
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Function Keys and Ctrl Key Combinations
	 F1	 Help

	 F2	 Drop-down menu or dialog for current field

	 F4	 Toggle between Cash Flow Data and Amortization Schedule

	 F5	 Input Setup

	 F6	 Compute Setup

	 F7	 Report Setup

	 F8	 Event Names

	 F9	 Calculate unknowns

	

	 Ctrl+A	 Select all

	 Ctrl+B	 Calculate a balance

	 Ctrl+C	 Copy

	 Ctrl+D	 Delete cash flow line

	 Ctrl+E	 Expand cash flow lines

	 Ctrl+F	 Sort cash flow lines

	 Ctrl+I	 Insert cash flow line

	 Ctrl+K	 Restore Unknowns

	 Ctrl+N	 Create a new schedule

	 Ctrl+O	 Open a saved schedule

	 Ctrl+P	 Print

	 Ctrl+R	 Check Rounding

	 Ctrl+S	 Save

	 Ctrl+T	 Totals

	 Ctrl+U	 Calculate unknowns

	 Ctrl+V	 Paste

	 Ctrl+X	 Cut

	 Ctrl+Z	 Undo

Appendix A: Keyboard Shortcuts / Right-click Menu
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Special Keys
	 K or T	 (In an amount field) Multiplies amount by 1,000

	 H	 (In an amount field) Multiplies amount by 100,000

	 M	 (In an amount field) Multiplies amount by 1,000,000

	 1x, 2x, 3x, etc.	 (In an amount field) Weighted unknowns

	 d or m or y	 (In a date field) Adds one day or month or year

	 D or M or Y	 (In a date field) Subtracts one day or month or year 

	 Event menu	 Type the first letter of an event to choose that event

	 Compound	 Type the first letter of a compound period to choose that compound period
	 period

	 Period	 Type the first letter of a period to choose that period

Right-click Menu
	 	 When you click your right mouse button on a cash flow line the following 

drop-down menu will appear:

	 	 Use this menu to quickly insert or delete cash flow lines, select a Special 
Series, access custom Event Names, and enter Points and Fees for APR 
calculations.

	 	 The menu above will appear when you right click on a cash flow line that has 
a Payment, Deposit, or Withdrawal event.  If the first event is a loan, the  
drop-down menu for that line would contain a Points & Fees selection.

Appendix A: Keyboard Shortcuts / Right-click Menu

Right-clicking on 
a cash flow line  

displays the drop-
down menu
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	 	 Many topics touched upon in this user's guide are explained in greater detail 
within the TValue amortization software Help system.  The help system is 
available by selecting TValue Help Contents from the Help menu or by 
pressing F1 from most fields in TValue amortization software.

		  Some topics that are expanded on in the TValue software Help include the 
following:

	 •	 Add-on interest

	 •	 Annual Percentage Rate (APR)

	 •	 Annual Percentage Yield (APY)

	 •	 Balance calculations

	 •	 Compounding periods: Monthly, Quarterly, Semiannual, Annual, Exact 
Days, Daily, Weekly, Biweekly, Half-month, 2-month, 4-month, 4-week, 
and Continuous.

	 •	 Interest computation methods: Normal (Compound interest), U.S. Rule 
(Simple interest), Canadian,  and Rule of 78.

	 •	 Internal rate of return (yield)

	 •	 Multiple loans

	 •	 Negative amortization

	 •	 Odd days and stub periods

	 •	 Simple interest

	 •	 And much more...!

Appendix B: TValue Software Help System



Appendix 99

	 	 For those who are accustomed to using TValue software, version 4, we welcome 
you to TValue software, version 5.  Version 5 delivers a host of new and 
enhanced features and an improved, easier-to-use interface.  We have listed 
the changes you should know about within this document.  This is not an ex-
haustive list of differences between TValue software, version 5 and previous 
versions, but it describes the changes that will be noticed by the experienced 
TValue software user.

		  For a more complete look at the new and enhanced features in TValue 
software, version 5, go to the TValue software Help menu and choose What's 
new in TValue. 

Click the Amortization Schedule tab to calculate and amortize

	 	 Instead of clicking on Calculate and Amortization buttons, now just click 
on the Amortization Schedule tab or press the F4 key to calculate and 
display the amortization schedule.

	 	 You'll notice the All, Part, or Totals only choices have been removed for 
quicker access to the schedule.  To print only a portion of the shedule, 
click the Report Range button in the Report Setup dialog.  Totals Only 
can be selected from the Report Setup dialog also.

Use long file names for your saved schedules

	 	 Use as many characters as you need to give file names to your saved 
schedules.  And, if you wish to change the default Save and Open 
directory, choose Input Setup from the Setup menu and select the 
default directory.

Right-click menu from a cash flow line

	 	 Use the right mouse button on a cash flow line to access editing 
commands as well as Special Series, and Points and Fees.

SS and PF buttons replaced by right-click

	 	 The Special Series, and Points and Fees dialogs are available by using 
the right mouse button or clicking on the far right column of a cash flow 
line.  Two new special series have been added: Monthly Skip and Princi-
pal First.

Where are the Setup menus?

	 	 The Input, Compute, and Report Setup dialogs have been consolidated 
onto the Setup menu.  

Appendix C: Changes from TValue Software Version 4
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Appendix C: Changes from TValue Software Version 4

Custom event names have moved to the Event Names dialog

	 	 To create event names such as Lease, Investment, Savings, Bond, etc., 
you can use the new Event Names dialog.  You can create up to three 
custom names for each user event, You can reach the Event Names  
dialog by choosing Event Names from the Setup menu or by pressing F8.

Label field defaults as file name

	 	 The first 50 characters you enter in the Label field will default as the file 
name when you Save.  You will be able to edit the final file name before 
saving.

Principal First payment allocation is now a special series

		  You no longer have to allocate a Normal payment to make a principal 
first payment when interest is accrued.  Now just right-click the payment 
line, choose Special Series, and select Principal First.

New Sort command replaces Merge All and Compress

		  The Sort command on the tool bar allows you to enter events without 
being concerned whether the dates are in order.  This command will also 
perform the same function as the Compress command did in version 4.

Totals command now on the Amortization Schedule window

		  The Totals button has been moved to the Amortization Schedule window.  
You can also access the Totals command from the Compute menu.

Delete cash flow lines without selecting the entire line

	 	 Just click on any field in a cash flow line and then click the Delete button 
on the tool bar.

Detail Lines replaced by Totals Only in the Report Setup

		  To turn off the details of the individual payments in an amortization 
schedule, select Totals Only in the Report Setup dialog.
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Appendix C: Changes from TValue Software Version 4

Export schedules directly to Microsoft Excel and Word

		  The Send to Excel and Send to Word buttons on the Amortization 
Schedule window will instantly export the schedule for editing.  For 
versions of Excel and Word earlier than '97, choose Export Schedule 
from the File menu.

Delete unwanted saved TValue software files easily

	 	 Version 4 users will appreciate the ability to easily delete unwanted 
TValue amortization software files.  Just choose Open from the TValue 
software File menu and locate the file(s) you want to delete.  Right-click 
the file you want to delete and choose Delete.

Availability for up to 3,999 events per cash flow line

	 	 This limit has been lengthened from 999 to allow even more options 
when structuring loans or investments that cover prolonged time periods.

Enter up to 4,000 cash flow lines

	 	 The version 4 limit of 400 cash flow lines has been increased so now 
you can enter the individual payments for a 30-year loan with weekly 
payments.

New, Open, and Save commands on the tool bar

	 	 Now it couldn't be easier to perform these common file functions.  No 
more hunting through the File menu when you want to save or open a file.

Display and print over 15,000 lines of information

	 	 For greater levels of detail on reports over longer periods of time, you 
now have the benefit of expanded amortization schedules.

Input and calculate larger dollar amounts up to 9.99 billion

	 	 Now you can enter up to 9,999,999,999.99 in normal display mode and 
up to 999,999,999,999 in whole dollar mode.
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Amount
	 calculating  30
	 deposit  30
	 entering  30
	 loan  30
	 payment  30
	 unknown  11, 30
	 user events  30
	 weighted unknown  31
	 withdrawal  30
Amount financed  53
Amount step series  44-45
Annual compounding  98
Annual percentage rate (APR)
	 calculating  54
	 explanation  98
	 including APR information on report 54, 72
	 points & fees  52
Annual percentage yield (APY)  98
Annual totals  72
Annuity  98
Appendixes
	 appendix A  96-97
	 appendix B  98
	 appendix C  99-101
APR  See annual percentage rate
APY  See annual percentage yield
Arranging cash flow lines  36-40
ASCII  See Exporting an amortization schedule

B
Balance calculations  60
Balance date  60

INDEX

2-month compounding  98
360 day year  63
364 day year  63
365 day year  63
4-month compounding  98
4-week compounding  98

A
Accelerated pay down of mortgage—
         88
Accrued interest - example  93-94
Action bar  See Tool bar
Actuarial  See Normal amortization
Additional principal payment - example  88-91
Amortization schedule window  21, 68
Amortization schedules
	 See also Report
	 compute method  62
	 creating  67
	 displaying on the screen  68
	 exporting
		  to a file  70
		  to Microsoft Excel  69
		  to Microsoft Word  69
	 font  75
	 footers  74-75
	 headers  74-75
	 printing  68
	 report range  75
	 samples  13, 67
	 saving  14
	 setup  71-75
	 totals only  72
	 tutorial  13
Amortize command  F4
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Balloon payment
	 example  79-80
	 rounding option  57-58
Biweekly compounding  98
Biweekly mortgage—example  88-91
Bond calculations  98
Buttons - tool bar  20

C
Calculate
	 See also Compute
	 amount  30
	 APR—example  52-54
	 balance  60
	 calculate unknowns command  57
	 interest rate  24
	 number  32
	 rounding amount  57
	 unknowns  56-57
	 unknowns—tutorial  11-12
Canadian
	 amortization  63-64
	 options
		  Canadian basis  64
		  odd days  63-64
Cash flow data window  20-21
Cash flow lines
	 arranging  36-40
	 compressing  See Sorting
	 copying  36
	 definition  26
	 deleting  37
	 entering  26-35
	 expanding  38-39
	 inserting  37
	 introduction  26
	 moving  36
	 sorting  40
Changes from TValue version 4  99-101

Balloon payment

Charges  See Points and Fees
Choosing
	 compound period  23
	 event  26
	 period  33
	 rate period  23
Close command  5
Closing a schedule  5
Commission Event  See User events
Common examples  77-94
Comparing mortgage interest costs—
  example  88-91
Compound interest  62
Compounding period
	 choosing  8, 23, 98
	 default  23
	 explanation  23
	 for a rate change  34-35
	 TValue tour  8
Compressing cash flow lines  See Sorting
Compute
	 See also Calculate
	 menu  56
	 method  62-63
	 settings  56-57  See Also Compute setup
	 unknown  56-57
Compute setup
	 Canadian options
		  Canadian basis  63-64
		  odd days  63-64
	 changing  62
	 compute method
		  Canadian  63-64
		  Normal (compound)  62
		  Rule of 78  63
		  U.S. Rule (simple interest)  62
	 default  61-62	
	 overview  61
	 year length  63
Computing  See Calculate
Contents  v
Continuous compounding  98
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Copy
	 cash flow line  36
	 command  36
	 text  36
Copyright  ii
Cut command  36

D
Daily rate  See Interest Rate
Date
	 counting  98
	 end date  33
	 entering  29-30
	 out of order  30
	 sorting  40
	 TValue tour  9-11
Default
	 compute setup  61-62
	 directory  16, 66
	 input setup  64-65
	 report setup  71
Delete
	 button  37
	 cash flow line  37
	 command  37
	 TValue files  15
Deposit
	 amount  30-31
	 event
		  choosing  26
		  definition  27
Discounting a mortgage or trust deed—
  See present value example  87
Displaying
	 amortization schedule  13, 67-68
	 fiscal year totals  73
	 totals summary  59
Dollar step payment  See Amount step payment

Exact days compounding

E
Edit menu  36
Effective annual rate  See Interest rate
End date  33
Entering data
	 amount  9-11, 30-31
	 compound period  8, 23
	 date of event  9, 29-30
	 schedule label  See herein label
	 interest information  9, 23-25
	 interest rate  9, 24-25
	 interest rate for a rate change  34
	 label  8
	 loan charges  See herein points and fees
	 loan fees  See herein points and fees
	 number of events  32
	 overview  19-21
	 points and fees  52
	 rate change  34
	 rate period  23
	 sample loan information—tutorial  8-12
	 special payment series  See Special series
	 unknown
		  amounts  31
		  interest rate  25
		  number of events  32
Event
	 choosing  26-28
	 deposit  27
	 loan  27
	 payment  27
	 period  33
	 rate change 28
	 selecting  See herein choosing
	 user events
		  choosing  26-27
		  creating  28-29
	 withdrawal  27
Event names  See User events
Exact days compounding  98
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Examples
	 balloon payment  79
	 common  77-94
	 investment  92-94
	 leasing  82-85
	 mid-loan activity  79
	 mortgage  88-91
	 special series  80-81, 86
	 TValue tour  8-16
Existing fixed series
	 explanation  49-50
	 generating  49-50
Exiting TValue  5
Expand
	 button  36, 38
	 command  36, 38
	 expanding cash flow lines  38-39
	 explanation  37-38
Exporting an amortization schedule
	 to a file  69-70
	 to Excel  69
	 to Word  69
	 to XML  70

F
4-month compounding  98
4-week compounding  98
Fees  See Points and fees
File  See Schedule
Finance charges  See Points and fees
Fiscal year totals  73
Fixed principal + interest payments  43-44
Font for report text  75
Footers  74-75
Formatting text See Font for report text
Function keys  96
Future value—example  93

Examples

G
Geometric series  See Percent step payments
Guarantee  ii

H
Half-month compounding  98
Headers  74-75
Help
	 about a particular field  16
	 about a particular topic  16
	 for more information about TValue  21, 98

I
Icons  See Buttons
Input assistance window  16
Input setup
	 changing  64-65
	 compounding  65
	 date of second cash flow line  65
	 default settings  64-65
	 event  65
	 initial directory  66
	 overview  61, 64
	 show warning if line has multiple loans  66
	 whole dollar  66
Insert
	 button  37
	 command  37
	 cash flow line  37
Inserting a cash flow line  37
Installing TValue  3
Interest computation methods  62-63
Interest on interest  See Normal amortization
  and U.S. Rule
Interest only series
	 entering  42-43
	 example  86
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Interest rate
	 calculating  24
	 daily rate
		  entering  24
		  explanation  25
		  including on schedule  72-73
	 effective annual rate
		  entering  24
		  explanation  25
		  including on schedule  72-73
	 nominal annual rate
		  entering  24
		  explanation  25
		  for a rate change  34
		  including on schedule  72-73
	 periodic rate
		  entering  24
		  explanation  25
		  including on schedule  72-73
Interest rate—tutorial  9
Invest event  See User events
Investment examples  92-94
Internal rate of return (IRR)—example  92

K
Keyboard shortcuts  96-97

L
Label  30
	 adding  22
	 editing  22
Lease
	 event  See User events
	 examples  82-85
Lease payment event  See User events 

Loan
	 amount  30-31
	 event
		  choosing  26
		  definition  27
	 charges  See Points and fees
	 fees  See Points and fees

M
Margins  75
Menu bar  19
Menus  19
Month-based compound periods  98
Monthly compounding  98
Monthly skip series
	 entering  47
	 example  80-81
Mortgage example  88-91
Moving
	 cash flow line  36-37
	 text  36

N
Negative amortization  98
Network installation  3
New schedule  14
Nominal annual rate  See Interest rate
None - no compound rate change  35
Normal amortization
	 example  78
	 explanation  62
	 setting compute method  62
Normal payments  42
Number of events
	 calculating  32
	 entering  32
	 unknown  32

Number of events



Index 107

O
Odd days
	 Canadian calculations  64
	 computing interest on  98
	 explanation  98
Open balance  58
Open command  15
Opening
	 default directory  16
	 file  15
	 new  22
Opening a file—tutorial  15
Other charges  53

P
Paste command  36
Payment
	 amount  30-31
	 event
		  choosing  26
		  definition  27
	 period  33
	 series  See Special series
Percent step series  45-46
Period  33
Periodic rate  See Interest Rate
Points  52-53
Points and fees
	 command  52
	 dialog box
		  amount financed  53
		  amount of loan  52
		  other charges  53
		  points paid on loan  53
		  prepaid interest days  53
	 entering  52
	 Reg. Z disclosure  54
Preferences  See Settings
Prepaid interest days  53
Present value—example  87

Principal first series 51
Print button  68
Print command  68
Printing
	 amortization schedule  13, 68
	 APR totals  54  See also herein totals
	 footers  See Footers
	 headers  See Headers
	 part of a report  See Report range
	 report setup  71-75
	 totals only  72

Q
Quarterly compounding  98
Quitting TValue See Exiting TValue

R
Rate change
	 event
		  compounding period  35
		  definition  28
		  entering  34
Rate period  23
Registering TValue  2
Report setup
	 cash flow data  74
	 changing  71
	 default settings  71
	 footer  74-75
	 header  74-75
	 margins  75
	 rate information to include
		  daily rate  73
		  effective rate  73
		  nominal rate  72
		  periodic rate  73
		  rate changes  73
	 report range  75

Odd days
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Report setup  (continued)
	 rounding message
		  description  73
		  end of report  73
		  none  73
		  separate page  73
	 information to include
		  annual totals  72
		  APR information  72
		  compounding  72
		  date  72
		  grand totals  72
		  label  72
		  page break before amortization  87
		  quarterly totals  72
		  time  72
		  totals only  72
Report range  75
Report setup dialog  71
Reports  See Amortization schedules
Restore unknowns command  59
Retrieve file  See Opening
Return on an investment example  92
Right-click menu  97
Rounding amount  
	 calculating  12, 57-58
	 description  57
Rounding message
	 end of report  73
	 none  73
	 separate page  73
Rule of 78  63

S
Sample problems  See TValue tour and 
  Examples
Save As command  14
Save command  14

Saving
	 defaults  See herein settings
	 documents  See herein files
	 files  14
	 default directory  16
	 different file format  See Exporting an
	     amortization schedule
	 preferences  See herein settings
	 schedules  14
	 settings  62, 65
Saving a TValue file—tutorial  14
Schedule
	 closing  5
	 deleting  15
	 new  14
	 opening  15
	 printing  See Printing
	 saving  14
Selecting cash flow lines  38
Semiannual compounding  98
Series  See Special series
Settings
	 compute setup  62-64
	 fiscal year  73
	 font/style  75
	 header/footer  74-75
	 input setup  64-66
	 report setup  71-75
	 user events  28-29
Simple interest  See U.S. Rule
Simple loan example  8-16
Skip series
	 entering  48-49
	 monthly skip series  47
Solving for
	 See also Calculate
	 unknowns  56-57
	 unknowns—tutorial  11
Sort command  40
Sorting cash flow lines  38, 40

Sorting cash flow lines



Index 109

Special series
	 creating  41
	 entering
		  amount step series  44-45
		  existing fixed payments  49-50
		  fixed principal + interest series  43
		  interest only series  42
		  monthly skip series  47
		  normal series  42
		  percent step series  45-46
		  principal first series  51
		  skip series  48-49
	 examples  80-81, 86
	 overview  41
	 points and fees  64-65
Spreadsheet  See Exporting an amortization
  schedule
Start date  See Date
Starting TValue  5
Stub period  98
Summary of totals  See Totals
Support Call 800.426.4741 or 949.727.1800
System requirements  2

T
2-month compounding  98
360 day year  63
364 day year  63
365 day year  63
Technical support  ii  Call 800.426.4741
Text file  See Exporting an amortization
  schedule
Tool bar  20, 36
Totals button  59
Totals command  59
Totals summary  59
Tutorial  See TValue tour
TValue tour  7-18

U
Undo command  36
Unknown
	 entering
		  amount  31
		  interest rate  25
		  number of events  32
	 entering—tutorial  10
	 restoring  59
	 solving for  57
	 solving for—tutorial  11
	 weighted  31
Upgrading from an earlier version  4, 99-101
U.S. Rule (no compounding - simple interest) 62
User events
	 choosing  26-29
	 creating  28-29
	 explanation  28-29

V
Value
	 future - example  93
	 present - example  87
Version 5 changes  99-101
Viewing an amortization schedule  See
  Displaying, amortization schedule

W
Weekly compounding  98
Weighted unknowns  31
Withdrawal
	 amount  30-31
	 event
		  choosing  26
		  definition  27
	 period  33
	 series  See Special series

Special series
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Word processing  See Exporting an amortization
  schedule
Working directory  See Default directory

X
XML - exporting  70

Y
Year
	 fiscal  73
	 length  63
Yearly totals See Annual totals
Yield  See Internal rate of return

Yield
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Solutions for
Financial Professionals

TValue™ 
Amortization Software, Version 5

TimeValue Software™ TValue™ amortization software is the industry standard for accurately amortizing 
loans, leases, and any time value of money calculation. All the top 100 accounting firms and more than 
500,000 financial professionals worldwide rely on the ease-of-use, accuracy, and flexibility of TValue 
amortization software. With TValue amortization software, you can solve any time value of money 
calculations and print amortization schedules in seconds. If you deal with loans that have irregular 
payments, balloons, or rate changes, then TValue amortization software is the tool you need. No matter how 
simple or complex, TValue amortization software makes it easy and saves you time.

TValue Engine™ 

Software Development Kit

TimeValue Software™ TValue Engine™ development software is the same calculation engine that powers 
TValue™ amortization software and is a proven source for software developers. The TValue Engine software is 
an ActiveX (COM), dynamic link library (DLL) that easily links to your front-end application to create accurate 
calculations. With the TValue Engine development software, you can integrate numerous financial calculations 
into your application while substantially reducing your development time.

TCalc™  
Online Financial Calculators

Your website should reflect the level of service and value you provide to your clients/customers. With 
easy-to-use TCalc™ online financial calculators from TimeValue Software,™ you can instantly profession-
alize your website with customizable, user-friendly online financial calculators that will give your clients/
customers a tool for everyday financial decisions. Research shows that Internet-based financial calculators 
are one of the most popular pages on a website. TCalc online financial calculators provides a complete set 
of calculators that are professional, informative, educational, and easy-to-use. TimeValue Software TCalc 
online financial calculators can be up and running in minutes and seamlessly integrates into the exact look 
and feel of your website. Your clients/customers will benefit from using TCalc online financial calculators 
to help answer everyday financial questions (e.g., mortgage, investment, retirement, personal, and leasing). 
To see a complete list of TCalc calculators please visit www.TimeValue.com/tcalc.aspx

Products from TimeValue Software
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Solutions for
Tax Professionals

 
TaxInterest™ 

IRS/State Interest and Penalty Software

Accurately calculate interest and penalties on federal income taxes, calculate interest on state income taxes, and 
perform FIN 48 interest calculations. When you prepare an amended or late return, do you guess at the penalty 
amount and tell your client to wait for the penalty notice from the IRS? When a notice of penalties and interest 
arrives, do you glance at it to see if it “looks right”? If so, there is a better way. Let TimeValue Software™ 
TaxInterest™ IRS/State interest & penalty software be your interest and penalties expert.

PayrollPenalty™ 

Failure to Deposit Penalty Abatement Software

As a tax professional, you are bound to see IRS payroll deposit penalties. One in three businesses pays a penalty each 
year for not making their deposits on time. The shocking fact is that taxpayers are being significantly overcharged 
by the IRS. TimeValue Software™ PayrollPenalty™ failure to deposit penalty abatement software can help you 
instantly and substantially reduce IRS failure-to-deposit payroll penalties for 940, 941, 943, and 945 filings, with 
100% acceptance by the IRS. By using allocation methods allowed by tax law (REV. PROC 99-10), PayrollPenalty 
software can save your clients thousands of dollars per filing. Ask us about our special bundle pricing discount when 
you also purchase Tax941 software.

Tax941™ 

IRS Payroll Tax Interest, Penalty, and Forms Software

Accurately predict and verify IRS payroll tax interest and penalty calculations, and reliably print error-free IRS 
payroll tax forms. Each year, the IRS sends out more than 4 million payroll penalty notices. Until Tax941™ IRS 
payroll penalty, interest, and forms software from TimeValue Software, there was no easy way to see if a penalty 
was right. With Tax941 software, you can double check an IRS notice in minutes. Tax941 software also gives you 
peace of mind in knowing that the IRS forms you produce are error-free. Comprehensive error-checking assures 
accuracy that is second to none. Ask us about our special bundle pricing discount when you also purchase Payroll-
Penalty software.

File In Time™ 

Due Date Tracking and Task Management Software

Easily and efficiently track all due dates and manage every task in your office. Keeping track of all the time sensitive 
jobs in your office, your staff workloads, and filing dates can be overwhelming to manage. Index cards, calendars, tax 
software, and spreadsheets all eventually fall short. TimeValue Software™ File In Time™ due date tracking and task 
management software is guaranteed to make your task tracking easier and help your firm run smoother. You’ll easily see 
the progress of your office workflow and be assured that no deadlines will slip through the cracks.

Products from TimeValue Software



TimeValue Software
22 Mauchly
Irvine, CA 92618

Phone:	1-949-727-1800
           	1-800-426-4741 (within USA)
Fax:     	1-949-727-3268
Web:	 TimeValue.com

Technical Support
Phone:	1-949-727-1800
          	1-800-426-4741 (within USA)
Email:	 support@TimeValue.com

Customer Service
Phone:	1-949-727-1800
          	1-800-426-4741 (within USA)
Email:	 info@TimeValue.com

Guarantee
If you don’t have a need for any TimeValue Software product, you may return it within one year 
of purchase and TimeValue Software will promptly refund the purchase price, less shipping and 
handling charges.

Copyright © 2010 TimeValue Software, Inc. All rights reserved.  Printed in the United States of America.
TimeValue Software, TimeValue, TValue, TValue Engine, Tax941, PayrollPenalty, TCalc, TaxInterest, TaxInterest Engine, and File In Time 
are trademarks of TimeValue Software, Inc. and its affiliates in the U.S. and other countries.  All other names may be trademarks of 
their respective owners. When you purchase a product of TimeValue Software, you are authorized to use it according to the terms of 
the license agreement. You may not make backup copies at anytime. Please respect the rights of TimeValue Software and refrain from 
distributing copies of this software. Such practices are in violation of copyright laws. TimeValue Software licenses its software on a
per user basis. This means that each user must pay for their own copy of TimeValue Software products.

The product described in this document is distributed under licenses restricting its use, copying, and decompilation/reverse engineering.

TIMEVALUE SOFTWARE SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION 
WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS 
DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.
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